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vUxoploTiee

Oa nBeAa va euxapIoTowW TOV KaBnyntr) Tou TufPoatog MNxavikwv HAEKTPOVIKWV
YToAoy1oTwV, TNAETTIIKOIVWVIOV Kal AIKTUwY, Tou lMavemmiotnuiov ©sooaAiog Kal
KUOPIO ETUPRAETIOVTA TNG SITTAWMPOTIKAG POV gpyaaoiag K. Mewpylo ZTAaPOVLAN TIOL HOL
€dW0OE TNV ELKAIPIO VO TIPAYUOTOTIOINOW aUTA TNV HYEAETN. H vmootpién tou, n
OUEPIOTN OUMPTIAPACTOCH] TOU, OAAG Kal Ol JIOPKEIC KAl e0OTOXEC UTTIODEIEEIC Kal

TIAPATNPACEIC TOL, UE BorBnoav aTnV EyKaipr OAOKANPWAON AUTHC TN HEAETNC.

Emiong, 6a nbsAa va suxapiotiow Tov €1EPO ETRAETTIOVIO KOABNyNTr Tou idlov
Tunuatog, K. Néotopa Euvupop@otmouvio. O yvwoel tou Kal n Ponbsid tou
OTIOTEAECQV TO BEPENID TNC TIPOCTIABEIOC VIO A 000 TO dLVOTOV KAAUTEPN KAl TIIO
EUTIEPIOTATWMEVN TOpouaiaon Tou Béuotog. Aev Ba pmopovoa va &EXAow Tov
TIPOTITUXIOKO POITNTI TOL TUAUATOC KAl TIPOCWTIIKO pou iAo, ABavaaio MNavveToo

yla TV apepiotn Bonoeia Tov Jou TIPOCEPEPE.

TéNOC, Ba nBeAa va ELXOPIOTOW TOUC YOVEIG PHOU Kal ToV adep@d pou Mdavvn yia
TNV UTTOCOTHPIEN TIOU POU €3WOOV KAl TIOU PoU divouv ag OAa Ta Bruata ¢ {wnc
pou. ETtiong euxaplotw OAOLC TOUC PIAOUC POUL Ol OTIOIOI PHOU CUUTIOPOCTABNKAV
OUEPIOTA KOB' OAN TN JIAPKEID EKTIOVNONG TNG JITIAWUATIKNC AUTHC EPyATiag Kal
KaB' 0An v dlApKEIa NG @OoITNTIKAC Pou {wr¢ ato BoAo kal oto Mavemotiuio
OecooAiog.
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| E looywyn

H e@apuoyr) mou avattuxbnke, ota TIAdicIo ATt NG SITTAWUATIKAG €pyaaiag,
vAoTtoinenke TAvw O¢ €va EKTTAIOEVTIKO EVOWMUOTWHUEVO cUOTNUA, TNG ETAIPINC
ADI, X-board.

TO EVOWPATWHPEVO AUTO cVOTNUA, TIEPIEAAUPBAvE TO eTteéepyaaTn TG Talpiag Intel,
XScale, 0 ortoiog ival e1dIKA aXEDIOCUEVOC VIO EVOWUATWUEVO CUCTHUOTO, KOl TOU
oTtoiou n oxediaon €xel Baoiotei MAvw otov emegepyactry ARM, apPXITEKTOVIKAG
RISC. O ouvduaoudg autdg, €TUAEXONKE d10TI 0 eTeéepyaatrg XScale, gival €vag
aTI0 TOUG TIAEOV GUYXPOVOUG KOl €EEAIYUEVOULC ETIEEEPYOOTEC VIO EVOWMPATWHUEVA
OLOTAMOTA OLTAV TNV CGTIYUA KAl XPNOIUOTIOIEITalI G€ TIANBWPA TETOIWV CUOKELWV.
O o¢ eme€epyaotic ARM, oTou ortoiou TNV oxediaon €xel BaoloTei 0 ETEEEPYATTAG
XScale, xpnolyoTtoleital EvpUTATA, CHUEPO OE EQPAPUOYEC OTIWG TO ipod nano tNg

Apple, 10 PSP tn¢g Sony, 1o Game Boy Advance.



To yeyovog auTto, Kal N €TIAOYN QUTH TWV CUCTNPATWY yio TNV avAamtuén tng
epapuoyng, €dwaoe TNV duvatoTNTO CGTO VA 00XO0ANBOUUE PE TIEPIOCOTEPO (NA0
MAvw O¢ KATI TO OT0I0 TIPAYMOTIKA OOUAEVEl KOl KUPIOPXED TNV ayopd Twv
EVOWPOTWHEVWY CUOTNUATWY CAUEPQ.

K epdiaio 1

MepiAnPn TwV BACIKWY OPXWV TWV EVOWUOTWHEVWY CUCTNHATWY

ANABel0... TI OKPIBWC gival éva eVvowuatwpévo oLOTNU; Evowuatwpévo avotnua,
gival éva ULTTIOAOYIOTIKO OUCTNUO TO OTIOI0 €XEl WC KUPIO AEITOUPYIKA KOl
UTTOAOYIOTIKI] HOVAda €vav  UIKPO-€TIEEEPYAOT). O MIKPOETIEEEPYNOTIC QUTOC
XPNOIUOTIOIEITAlI OTO VA EAEYXEl PIOC TIANBWPO EQPOPUOYWV KOl AEITOLPYIWV TOL
ouoTAPAToC autou.

Agv gival ommAd €vag LTIOAOYIOTAG PE TNV €LPUTEPN €VVOId TOU TIPOCWTIIKOU
UTIOAOYIOTA] TIOU OAol yvwpiloupe! Ol TIPOCWTIIKOI LTIOAOYIOTEG, VIO TTAPADEIYUA,
gival oxedlaopévol WaoTe va gival «yevikol TOTIOU» LTTOAOYIOTEG (general-purpose
computers). Mg Vv €vvola OUTr) €VWOOUUE, OTI Ol TIPOCWTIIKOI LTIOAOYIOTEG, KOl
YEVIKOTEPA Ol UTTOAOYIOTECG, «YEVIKOU TUTIOU» PTIOPOUV VO XPNCIYOTIoINBoUV ag Jid
TIANBWPA SIAPOPETIKWY EQAPUOYWV KAl AEITOLPYIWV. TO EVOWHOTWHEVA aUOTNUA,

€V QVTIBETEL, €ival oxedlaopéva ETOI WAOTE VA LAOTIOIOUV HIO HOVO AsIToupyia, 1 Eva



TIOAD OUYKEKPIUEVO KOl OPICHEVO OUVOAO aTiO Acitoupyieg. To yeyovog auto, armo
HOVO TOU, ATIOTEAEI TNV BIOXWPICTIKA VNoida PETAED TWV «KOIVWV», «YEVIKOU
OKOTIOU» LTIOAOYIOTWV KOl TWV EVOWUOTWHEVWY CUCTNHATWV.

Ermiong, Ta evowpatwuéva ouaTrPoTa, €ival TTOAD TIAPATIAVE ATIO €V ATTAO
TIPOOWTIIKO  LTIOAOYIOTH. [ TAPAdElyUD, TIOAD GCUXVA TO  EVOWHATWUEVO
OLOTAHATO OAANAETTIOPOUV HE TO PUOIKO TIEPIBAANOVY, TIOUL TOLG TIEPIBAAEL, €iTE ALTO
T0 TEPIBAAAOV ovouddetal, dWMPATIO OTITIOV, EITE QUTOKIVNTO €&V KIVIOEl, E€iTe
OEPOCKAQOC €V TITNOEL, €ITE OKOPO KAl £vOg TTUPNVIKOG avTIOPACTAPOC OE TIARPN
AglToupyia.

ATIO TNV MEPIA TOL XPNOoTn Twpd. MW¢ 0 XPAOTNC AVTIAGUPBAVETAL TNV
omapén evog EVOWUOTWHEVOL cLoTAUOTOg, O TEAIKOC XPNOTNG, 0 XPNOTHC TIOU
OAANAETUIOPA PE TOV EVOWUOTWUEVO OLOTNUO, <«BAETIE» Kl «Bewpei» OTI €XEI
aTtéVavTI ToU, OTI OAANAETIIOPA Kol OTI GUVOAAACCETOl PE Eva «EEUTIVO, ELPUEC,
YEVIKOU TOTIOU» OUOTNUO, €V OVTIBECEl PE TO YEYOVOC OTI TO UTIOAOYICTIKO TURUa
TOU CLOTHUATOC, OEV ATIOTEAEITAI ATIO TETOIOU «YEVIKOU» TUTIOU ETIEEEPYATTH.

H mopamavw eviumwaon dnUIOVPYEITAl TTOAD GUXVA OTOV TEAIKO XProTn TOU
EVOWHOTWHEVOU GLCTHHATOC, KABOTI TO EVOWPATWHEVO UGTNUA, T OEOOUEVA TIOU
OEXETAl oav €i0000 QULTO, OV UTTIOPOLV Va TPOTIOTIOINBOUY i va aAAdéouv 1 va
evnuePWBOUV aTteLBEing oo auTov.

TEAKA KOl pe amtd mopadeiypota, Tt €ival Eva VoOwUOTWHUEVO CUCTNUA;
A@OU TIPOXWPNOAUE GTNV ETIEENYNON TNE £VVOIAC «EVOWHATWHEVO GUCTNUO» KAl
oTNV PEPIKN ETIEENYNON TNG dlA@OPOTIOINCNE TETOIWV LTTOAOYICTIKWY GUCTNHATWY
aTi0 TA «YEVIKOU TUTIOU», UTIOPOUME VO TIPOXWPNOOLUE G€ OTITA Ttapadeiypata Ta
oTtoia amoteAolV TETol cuoTAuata. Mapadegiypota AOITIOV TETOIWV GUOTNUATWY
givar: Ta KIvNTa TNAEQWVA, Ol ATIOKWOIKOTIOINTEG WN@IOKAE O0PUQPOPIKAC Kal
ETTIYEIAC TNAEOPOONC, Ol OCUOKELEC TNAEOPOONG, Ol  TIAIXVIOOUNXOVEG, Ol
PuyeloKoTaPUKTEG, TO OULTOKIVNTA, T OEPOCKAEPN, Ol OVEAKUOTNPEG, TO
OUCTNUATO CUVOYEPUOU, TO GUCTHHOTA EAEYXOL EPYOCTOTIWVY, IOTPIKEC EPAPUOYEQ
OTIWC 0 PNUATOdOTNC, Ol SIAPOPEC JIOOTNOCUTKEVEG, KOl OAAG...

H ayopd Twv EVOWUOTWHUEVWY CLUOTNUATWY Eival aTAd TepdoTia. To £€1oC
2000 yia Tmopdadelypa, n ayopd Twv emnegepyooctwyv ATav TG TAENC Twv 8
OIOEKATOUULPIWY doANapiwY. Tnv idla xpovid, N ayopd Twv EMEEEPYATTWY Yid



EVOWUOTWHEVO CUCTHHOTA OTIOTEAOVCE TA 7-8 a0 TO 8 JICEKATOUMUPIO SOAAAPIA

TNC GUVOAIKNC OYOPAC TwV ETTEEEPYOCTWV TIAYKOTHIWC.

Al0(POPOTIOINCN EVOWUATWHEVWY CLCTNHATWY UE TA LTTOAOITIA
UTTOAOYIOTIKA cuoTAuaTa

Ti Ol0@OPOTIOIEl T EVOWUATWUEVO CLOTAUATO, CE OXEON HE TA UTIOAOITIO
ouotnuota; H dlagopotoinon, Tépa amo 1 dla@opd, HETAED TwV «YEVIKOU
OKOTIOU» UTIOAOYIOTIKWV CGULOTNUATWY, OTIWE AUTH ava@EPBNKE Ttapamndavw, ival 1o
YEYOVO(, OTI TO EVOWHATWHEVA CUCTPOTO  ETUTEAOUV  HIO  OUYKEKPIUEVN
AEITOLPYIKOTNTA, OnAOdH, HIO KOl PJOVO  AEITOLPYIKOTNTA N PEPIKEG
AEITOLPYIKOTNTEG PE ETTOVOANTITIKOTNTA. ZTNV BAcn auth Twv Ttapamavw, agidel va
avoepBei, 0TI 0t éva evowpaTwUévo cLoTnPa, Tto ULAIKG (hardware) Tou
EVOWMATWVETAI 0€ OUTO, €ival auTd KAl POVO aUTO OKPIBWC Kal TITTOTa TOPATIAV®
amd ouTO, TIOU TIOPEXEL TNV OCUYKEKPIYEVN AEITOLPYIKOTNTA TIOU OTTOITEL N
e@apuoyr. To TEAEUTAIO, CUVETIAYETAI, TIWG TO TIPOYPAUUA TNE EQPAPUOYNC TO OTI0I0
Ba TPEXEl «TTAVW» O€ €va TETOIO CUOTNUA, O €vO EVOWHATWUEVO olOTNUa, Ba
TIPETIEL VA €ival TIPOCGEKTIKA GXESIOTHEVO, LAOTIOINUEVO KOl TI(POCAPUOCHEVO YIO TO
cVLOTNPa autd Kal yia POvov auTo.

Ta eVOWUATWHEVA CUCTHPOTA TIOAAEC POPEC AVTIOPOLV Kol OAANAETTIIOPOUV
ME TO TIEPIBAAAOV TOUC KOl TNV AEITOLPYIKOTNTA OUTA TIPETIEI VO TNV dlATNPOUV GTO
oképalo. Mo Topddelyua, Eva eVOWUOTWHEVO CoUCTNUO TO OTIoi0 BpioKeTal Kal
OAANAETIIOPA PE TO TIEPIBAANOV TOU, O@EIAEl KOl TIPETIEL va avTIdPA KAl va
OTTOKPIVETAI OTIC OAANAYEC KOI OTIC ETIIOPACEIC TOL TIEPIBAAANOVTOC KOl VO LTTOAOYILEL
KABE @Opd, OCUYKEKPIYEVA QTIOTEAECUATA O  €VOTIOANTITIKA  Bdon. TETola
EVOWMOTWPEVO CULUOTAMOTA, TOA OTIoI0 GAANAETIIOPOUV HE TO TIEPIBAAAOV TOUC,
EVOWHOTWVOULV TIOAAEG POPEC BIOPOPOL TUTIOL CICONTAPEG KOl OVIXVEULTEC OTNV

OPXITEKTOVIKI] TOU OUGTHHATOC.



Ermiong, ouxvd avopuéVOUUE, TO EVOWUOTWHEVO CUCTHHUATO, VO €XOULV ETITIAEOV
1O10TNTEC, TIEPO TWV TIAPOTIAV®W PBOCIKWY, OTIWC N AEITOLPYIO TOUC GE TIPAYUOTIKO

Xpovo (real time).

MePIOPICHOI TWV EVOWHATWHEVWY CUCTNUATWY

MoAD ouXVd, TO EVOWUOTWHEVO CLOTAUOTA Eival oXedIOOUEVA UE BACN TIOAD
OUOTNPEC KOl CUYKEKPIUEVEC TIPOdIAYPOPEG Ol OTIOIEG, dUVOTAL, N HIO PE TNV GAAN
Vo OAANAETUIOPOUV  OVTIOYWVIOTIKA  HETaL Touc. [Mapadeiypata  TETOIWV

TIPOJIAYPAPWV:

> Mikpn TTOCOTNTA PVAPNG
H 0mopén pvAung Kol n 1moootnta ouTtAg, dUvaTal TIOAAEC QOPEC, va  Eival éva
ONUAVTIKO KAl avaTtOCTIO0TO KOUWATI TOL KOOTOUC TOUC CUCTHUATOG.

> Meéyebog, Bapoc.
MOAAEC (POPEC, TA EVOWHOTWHEVA CUOTHPOTA ETIIBLVPOVUE Va gival PIKPA o€ Bapog,
KOl o€ OyKo. Mapddelypa TETOIWV EQPAPPOYWVY HE TETOIOU EIBOUC TIPOSIAYPAPEC
gival Ta KIvnTa TNAEQPWVA KAl Ol OPNTEC NAEKTPOVIKEC GUOKEUEC.



> MiKpn KotavaAwaor 1ox0oc.
O1 Tepioplopéveg  duvatomnNte WYOENC TWV EVOWHATWHEVWY  CUCTNUATWY,
ETIRAANOVV Kal TNV 000 TO dUVATOV PIKPOTEPN dLVATH) KATAVAAWGN EVEPYEING OTIO

OUTA, OKOUO KAl av AEITOLPYOUV PE OTOBEPN TIAPOXN NAEKTPIKOV PEVUATOC.

> YUnAn emidoon
Mapd TOAD oUXVA TO EVOWUATWHEVO CUCTAUATA TIPETTIEL VO LTIOAOYIGOLV Kal va

ETUIOTPEYOLV ATIOTEAECUATA O€ IBIAITEPA PIKPO XPOVIKO SIACTNUA.

> MIKPO KOGTOG
Ta evowuatwWUéVO CULCOTAUATO TA OTIoI0 €XOUV WC Oyopd OTOX0 TO €upl
KOTOVOAWTIKO KOIVO TIPETIEL VO €XOUV QUTH TNV TIPoUTOBEDN, KOBOT, GE
EVOWUOTWHEVO CUCTHUOTA, PE PEYAAO OPIOUO ETIINEPOLE CLOTNUATWY, OKOPO Kal
0.05euro av&non oTnV TIUN TOU KABE ETUPEPOUC TUNMOTOC, WTIOPEI VO ETTIPEPEL
MEYAAN av&nan otnv TEAIKN] TIMA TIWANGCNG TOU TIPOIOVTOG OTNV ayopd.

> ETIKivOuvo TEPIBAANOV
To TmepIPaAAOvV péoO OTO OTIOI0 Ba AEITOLPYNCEL TO EVOWUOTWUEVO CLOTNUO
ouvatal va gival emikivouvo, va emnpeddlel Kal va OUOKOAEVEL TNV idla TV
AEITOLPYIKOTNTA TOU CUCTHHATOC, OTIWE YIO TIAPAdElyUA, TO SlACTNUA KOl Ol
OUVONKEC TIOV ETTIKPATOUV €KEQ, | TtEPIBAANOVTA e LTIEPPOAIKNA (ECTN 1) PE PEYAAEG
O0Vr\OElC.

> /\EITOLPYIKOTNTO KPICIUN YIA TNV 0CQAAELQ.

Ta eVOWPOTWHUEVA CUCTHPOTA dUvOTal va AEITOLPYoLV oe TEPIBAAAOVTA 1) va
UAOTIOIOUV E€QPAPUOYEC KPICIUEG, OTIWC TO UTIAOKAPIOHA TwV TPoXwv ot ABS oT0
OUTOKIVNTO, N 0 €yKAIPOC EVIOTIIOMOC KOl evnuépwan yia pia BAABn oe éva
0EPOOKAPOC €V TITUCEL [MEVIKA, €va EVOWUATWUEVO cVUOTNUA, TO OTI0I0 KOAEITAL va
vAOTIOINCEl EIOIKA TETOIEC TIPOUTIOBECEIC ATPAAEING, OPEIAEL VO AEITOLPYEI OwaTd
KOl TOUTOXPOVO O@EIAEL VO UNnV AEITOLPYEL AavBaouéva.

Mapddelypua  apXITEKTOVIKAG EVOWPATWHEVOL CUCTAMOTOC €ival 10 clOTNUA

AvTiuTIAOKOpiopaToC TpoXwv OTa AUTOKIVNTA, TO yvwoTto Kal w¢ ABS(Antilock
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Braking System). To O0Ao oUoTnua, otnpidetal OTO0 yeyovog, OTI KaBwG
EVEPYOTIOIOUVTOI T @PEVA  TOU OUTOKIVATOUL, Ol TPOXOi TOou, TaloLV vda
TIEPIOTPEPOVTAL, PE ATIOTEAECUO TO OUTOKIVNTO, va apXidel va oAloBaivel kal va
gival dVOKOAO, £w¢ adLVATOV va EAEyXEl N Topeio Tov. To ABS, ETITPETEI TNV
TIOPOdIKN) APECN TOL PPEVOU GTOUC TPOXOUC, WOTE OUTOI VO KUAOUV Kal va pnv
XAVETAlI 0 EAEYXOC TOU QUTOKIVITOU. H TIOpOdIKY) A@eECn TOU PPEVOL AOUPBAVEL
Xwpa, Povo €AV n TaxVTNTO TIEPICTPOQPNC TOUL TPOXOU, KOTA TNV OIAPKEI TOL
@pPEVApIoPATOC, Eival TTIOAUD UIKPN).
ATIO TO TTOPOTIAVW TTOPAdEIYHA, KOBIoTATOl COPEC TIWG Eva GUCTNHA GOV KAl auTo,
o@eilel va evowpatwvel TipolTToBEoelC agloTioTiog, ac@aleiag, KaBwg Kal Xpovou.
Aiyo Topamavw oTta TIPonyoUlEVa, avag@EépOnke, n €vvola OTI T EVOWHATWUEVO
cuoTtuata duvatal, va €XoUV 1I810TNTEC AEITOLPYIOG «TTIPAYUATIKOU XpOvou». Me
TNV €VVoIa aUTH ava@ePOPOOTE GTO YEYOVOG OTI OTA EVOWPATWUEVO CUCTAUOTA, N
OWOTH, XPOVIKA, AEITOUPYIKOTNTO TOUC, Eival PEPOC TNC CULVOAIKACG 0pBng Kal
OWOTHC AEITOLPYIOC TOL OAOV CUCTAUATOC. AlOKPiIVOLPE VO TIEPITITWOEIC:

> Hard Real-Time
Ta guoTtruota autd sival avatnPd, YE TNV €vvola, OTI AEItoupyolv, TTAPAyoLY Kal
OTEAVOUV OTIOTEAEOUOTO, PECO OE €va OTIOAUTWC QUOTNPA OPICHEVO XPOVIKO
TIAQiC10. Z€ KABE OIA@POPETIKN) TIEPITITWAN TIOU TO OTIOTEAECPOTA TtapaxBolv o€
XPOVIKO SIACTNUa, TIEPA TOL OPICHEVOUL, TOTE Eival OTTAG AXpnaoTa.

> Soft Real-Time
Ta ocuoTAUATO AUTA JIOPEPOLV ATIO TA TIPONYOUHEVA LUTIO TNV €vvola, OXI OTI dev
UTTIOKOUV O€ XPOVIKOUC TIEPIOPIOPOUE Kal TIAQICIO, OAAG TO OTI €XOLV TNV
AuVATOTNTO VO TIOPAEOUY TO OTIOTEAEGUA, VO ETUTEAECOUV TNV AEITOLPYIKOTNTA
TOUCG, KOl TIEPO OTIO TO OPIO TOU XPOVIKOU TIEPIOPICHUOU TIOU €XEI OPIOTEL. ME GAAa
AOy1a, €av TIOPaXOEl ATIOTEAECUO €KTOC TOU XPOVIKOU TIANIGIOU, TO YEYOVOC aUTO
O&V OTIOTEAEI KATI TO KOKO i} TO KATAGTPOYIKO yIa TO OA0 oUCTNHA.
A¢ TIpoLE Eva TTOPAdEIYUA YO va dIA@AVE( N d10QOPOTIoINGN Twv 600 TIAPATIAVK
Katnyoplwv. ‘Evag Pnelakog amokwdIKoToINTAg, éva DVD Player yia tapadelyua,
0 XPOVoC TIoL €Xel aTnV dIABeoN Tou, yIa TNV OTIOKWAIKOTIoINGT €vo¢ frame, €ival
OUOTNPO TIEPIOPIOUEVOC Kal KaBoplopévog ota 30 XIAIOOTA TOU OEUTEPOAETTTOU,

TIPOTOU TO €TIOUEVO frame €pBEI OTOV ATIOKWAIKOTIOINTH], YIO OTIOKWAIKOTIOINGT).
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KAgivovtaog To KEQAAQIO autd Kal tnv €MEENyNON TN €VVOIOG «EVOWHATWHEVO
oVOTNUAO TIPAYUATIKOU XPOVOUL», ATIOPAITNTO, €ival va TIPOXWPNOOUKE KAl GE Pia
oKopn emeénynon. To yeyovog OTI €va EVOWMATWPEVO clOTnUa €ival cloTnud
TIPAYHATIKOU Xpovou, dev anuaivel 0TI gival Kal ypriyopo! To va gival éva aOoTtnua
«ypPryopa» GNUAIVEL, OTI N AEITOLPYIKOTNTA TOU, ETTITEAEITAI PE «LPNAR TOXVTNTO,
«ypriyopa» OnAaodr]. AvtiBeta, To va gival éva cUOTNUO <TTIPAYMATIKOU XPOVOU»
onuaivel 0TI LAOTIOIEI KATIOILG, ALOTNPEOUC N HN, XPOVIKOUC TIEPIOPIOUOUE OTNV
eme€epyacia Twv OedOPEVWV KOl OTNV ETUTEAECN TNG AEITOUPYIKOTNTAC TIOU
LAOTIOIEL. 'Eva «Ttpayuatikol Xpovou» cUOTNUa, UTtopei KAAAIOTA va givarl apyd! H
oAnBela gival o1l Opwg OTI €ival emdIWE pag, va oxedidlovial «oLOTAUATA
TIPOYHOTIKOU XPOVOUL» TO OTIOIO va €ival ypriyopa Kal va AEITOUPYOUV 0€ LPNAEC

TaxVOTNTEG eTeéepyaaiag deOUEVIV KOl TTAPAYWYNC OTIOTEAECUATWV.

KA&TI To oTto10 B0 TIPETIEl VO TOVIOTEL YE PEYAAN U@ACN OTO ONUEIo auTo €ival to
YEYOVOC OTI Ol EQOPHOYEC TIOU UAOTTIOIOUVTOI TIAVW O€ EVOWHATWHEVA CLOTAUOTA,
Ba TpETEl VA Eival TIPAYUOTIKA «E0PWAOTES» (robust). Mo va yivel To KatavontA N
ouT KaBautry €vvola robust, Ba TIOPOLCIACTEL Eva TIPAYUATIKO TIPOBANUA TIOU
ENaPE xwpa TPV OTIO TIEPITIOL Hia deKAETia, iowg Kal AlyoTteEpo. O TTUPALAOPOPENC
N Evpwraikng Alaotnuiking Yminpeoiag (ESA), tou oroiou n avdamtuén KOoTIoE
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TEpi T N dloEKATOPMLPIA BOAAPIO, PETAPEPOVTOC POPTIo, NG Taéng Twv 500
EKOTOUMLPIWV dOANapiwY, €€gpyn KOTA TNV TIPWIN @ACN TN¢ €ktogsuong Tou. O
AOYOC TIOU TIPOKAAECE TNV KATACTPOEN OULTH, NTAV &va TIPOYPAUUOTIOTIKO AdBoC,
OTO AOYIOHIKO TOU OdPOVEIOKOU CULCTAPOTOC TOU TIVPOUAOUL. IO CUYKEKPIUEVQ,
évag 64-bit apiBudg KIvnTr¢ UTTOBIOCTOANC, METOTPETIOTAV OE TIPOCNHACUEVO i16-bit
OKEPAIO apIBPO. To yeyovog autd KOBwC Kal TO YEyovog OTI gV YIVOTOV OWOTH
olaxeipion 1n¢ €aipeong avt¢ (improperly handled exception), T0UL
TIPOKOAOUVTAV OTIO UTIEPXEIAION TNC MIOG PETAPBANTAG, 00rynaE OTNV KATAGTPO®)

TOUL TTUPAUAOU.

K £PANQIO 2

MNvwplpia pe tov emte€epyaotr) ARM

MEta amd TNV amapaitnIn auTh apXIKA ETEENYNON Twv BeueMwdwV apxwy Kal
OPICHWV, KOBWC KAl €QAPUOYWVY, TIAVW OTO OTIoi0 avaTttUXONKE N SITTAWUATIKNA
gpyacia avutr), akoAouBsi pia avaAuan NG apPXITEKTOVIKAG Tou emepyacty ARM,
oTnVv oToia TAvw gival Baciopévn N apPXITEKTOVIKN Tou emeéepyacty XScale tng
Intel, otov omoio mavw €yive n avartuén ¢ embedded e@appoyng (e@apuoyng
EIOIKA OXEDIOOUEVNC KAl LAOTIOINUEVNG VIO AEITOUPYIO OTO  OUYKEKPIUEVO

EVOWUOTWUEVO oLOTNHA).
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O emelepyaotic ARM, armoteAei pia vAoroinon g etaipeiag Advanced RISC
Machines, pe €dpa Tnv MeydAn Bpetavia. O XScale amoteAei tnv ékdoon VSTE tng
apxIteKTovikng ARM. Eival évag emeepyaotnc 32-bit, kal gival LAOTIOINUEVOC OTO
va pPtopel va uttootnpidel 2 ogOvoAda evioAwv (instruction sets). ‘Eva olOvolo
eVTOAWV 32-bit mou ovopddetal ARM Kai €éva GAA0 gUVOAO eVIOAWV 10-bit 10U
ovopaletal Thumb. H xpnoiudtnta tou o€t eviodwv Thumb gival anuavtikototn
KOBWC TO OET EVIOAWV QUTO, pag divel TNV duvatoTNTd, Va €E0IKOVOUOUUE VAN
aTI0 TOULG KATAXWPNTEG TOU ETIEEEPYOOTH], KABWC Yl PIKPOU peyeBoug Kal TOTIOU
oedopéva, Omwe short integers Kal char, avti va KPOTAUE ylo TOG0 WIKPO OYKO

0ed0UEVWVY pvnun 32-bit, KpaTAuE pvAun 10-bit, Kal €101 e€oIKovouEiTal yviun.

Baoikoi tpoTtol Asitovpyiag tou ARM

2TNV OULVEXEID, YiVeTal Topouaioon ETTA Pocikwv TOTIWV AEITOLPYIiag Tou

ene€epyacti ARM (basic operating modes).

O emeepyaotic ARM, d106€tel emTd PacikoUC TPOTIOLC - TUTIOUC AEITOLPYIOG

(operating modes):

> User mode: Eival 10 Baolkd mode AsItoupyiog Tou eMeEepyaatr) KATA TNV
OIAPKEIN TNG OTIOIOG €XOVUE TNV EKTEAECN TOUL TIPOYPAUUOTOC TOU XPHOoTH,
amoe 1oV €Te€epyacTr). € ouTO 10 mode, dev OIABETEl TIEPICCOTEPO
SIKAIWUATO 0 XPNOoTng, TEPO OO Ta PACKA JSIKAIWPATO TOU, OTIWG
TIPOOPOCN 0€ CLYKEKPIUEVOLCG KOTAXwPNTEG Kal BEaelg pvrung (unprivileged

or user mode)
> FIQ mode: XpnOIUOTIOIEITAI YIO TOV XEIPIOUO TwV OIOKOTIWV KOl TIIO

OUYKEKPIYEVA, YIO TOV XEIPIOPO TWV YPRyopwv JBIOKOTIWY, LWNANG

nipotepalotntag (fast interrupt handling). € autd 10 mode, £XouuE TIANPN
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EAEYXO TNC JIadIKOCIOC EKTEAEDNC EVIOAWV OTIO TOV €TIEEEPYATTH, 1} AANIWG

dikalwpata «uTtepxprot» (privileged or FIQ mode)

IRQ mode: XpPNGCIUOTIOIEITAI VIO TOV XEIPIOPO TWV XAUNANC TIPOTEPAIOTNTAG
olokoTiwv (low priority interrupt handling). Z€ autd to mode £xouue TANPN
EAEYXO NG dIAdIKOCIOC EKTEAECTC EVIOAWV ATIO TOV ETEEEPYATTN 1] OAAIWG
dlKalwpata «utepxpnotn» (privileged or IRQ mode), eival Ouwg
XOUNAOTEPO OE TIPOTEPAIOTNTA L'TO TO Mode, atd To mode Tou FIQ.

Supervisor mode: & auTtd To mode EICEPXETOI 0 ETIEEEPYOOTNC, OTAV YiVETAI
reset Kl OTOV EKTEAEITAI OIOKOTIN) TIPOEPXOUEVN ATIO TIPOYPOUMO TO OTI0IO TO
EXEl ypawel kKal To ekTeAei 0 xpnotng (Software Interrupt instruction
execution). e autd 10 mode €£xouphe TANPN €Aeyxo TNC OlodIKAGCIOG
EKTEAEONC EVIOAWV OTIO TOV ETMEEEPYOOT) N OAANKC  SlKalwuaATa
«uTepxpnotn» (privileged or Supervisor mode), €ival Opw¢ XaUNAGTEPO O€

TIPOTEPAIOTNTA OVTO TO Mode, amod 10 mode Tou FIQ.

Abort mode: To mode auTO XPNOIPOTIOIEITAL VIO VO YIVETOL XEIPICUOC TWV
apapiacewy pocBaong otnv puviun (Memory access violation handling).
Y& auTO TO mode, £xoupE TIANPN EAEYX0 TNC JIADIKOCIOC EKTEAECNC EVIOAWV
aTio TOV €TE€EPYaaTn 1 OANWC SIKAIWPOTA «LTIEPXPNOTN» (privileged or
Abort mode)

Undefined mode: To mode autd XpnoIUOTIOIEITAl YIO VO YIVETAI XEIPIOHOG
TWV UN OPICHEVWVY EVIOAWV, TWV AQVOOCUEVWVY EVIOAWV OTIO TO TIPOYPAUUO
Tou xpnotn mpo¢ tov emneéepyaotry (Undefined Instructions handling). Ze
ouTd T0 mode, €XOUUE TIANPN EAeYXO NG OIAdIKOCIOC EKTEAECNC EVIOAWV
amd tov emegepyaot | OAMWG JIKAIWUATO «UTEpXpProtn» (privileged or

Undefined mode)

System mode: To mode autd Aertoupyiag tou emegepyaatr), €ival &va
privileged mode, dnAadr pmaivovtag o€ autd To mode, £XOuLUE TTPpOoBaacn o€
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OAOUC TOUC TIOPOUC, MVAUN, KOTaXWPENTEC Kal Olepyaoieg, XEIPIOTEC
olokoTiwv (interrupt handlers), tou eme€epyaotr). To oualaoTikO 0to mode
OUTO OUWC €ival To yeyovog TwC €XOULUE OTNV OIABeaT) pag Toug idloug
OKPIBWE KATOXWPENTEG, TOUC OTIoioug €Xel Kal To User mode. Agv €XOupe
oNAadK, &eXwPIOTOUC KOTaXWPENTEG yia To mode autd, OTIWG OKPIBWG
ovpuPBaivel ota umtoAoita, User, FIQ, IRQ mode, 0mou og KGO mode €xoupe
TIPOcPacn oe JIAPOPETIKO LTIOGUVOAO TOU GUVOAOU TWV KATOXWPENTWV TOU

entegepyaotn. (MePICOOTEPO YIA AUTO OTNV CUVEXEID)

MeTA TNV TapoLciacn Twv ETTA SIAPOPETIKWY TPOTIWV — mode AEItoupyiag tou
ene€epyaotr) ARM, akoAouBei n Ttapouaiocn Tou GUVOAOU TWV KOTAXWPNTWY TOU
emegepyaotn.

O ARM, Jl106¢tel 37 KaTOXWPNTEG, MeyEBoug 32~bit. ATO autoug Toug 37
KOTaxwpntég, ol 30 XPnNOIYOTIOIoUVTAl K¢ KOTAXWPNTEG YEVIKOU okoTtol (general
purpose registers). ATO TOUC UTIOAOITIOUG N KOTAXWPNTEG TIOL OTTIOPEVOUVY, O 1
XPNOIUOTIOIEITAI OTIOKAEIOTIKA KOl POvo omo tov Metpnty Mpoypdupatog Tou
eneepyaotr), tov Program Counter dnAadni 1 oMw¢ PC. 'Evag okopa
KOTOXWPNTNC XPNOIUOTIOIEITAI OTIOKAEIOTIKA YIO TNV amobrkeuon tng TPEXOVCOC
KOTAOoTaoNG €KTEAeONG Tou Tipoypdppatog (Current Program Status Register -
cpsr). O TEAELTAIOG OUTOC KOTAXWPENTAG, OTIOBNKEVELI KAL TNV TEAEVLTAIO EVIOAN TIOU
EXEl EKTEAECTEI OTIO TOV €TECEPYaaTr). TEAOCG, LTTAPXOUV AAAOL 5 KOTAXWPNTEC, Ol
OTIOIOl XPNGCIKOTIOIOUVTAI YIO TNV aTtobnkevon Twv 0edouEVwY oL Bpiokovtal aTov
KOTOXWPNTA cpsr, akpIBwg Tipiv AdRel xwpa Mo e€aipeon (exception) aoT10
TIPOYPOUMO TIOU TPEXEL EKEIVN TNV wpa oTov emeéepyaot (Saved Program Status

Register - spsr).

Onwg eixe avagepBei kal TOPATIAVW, GTNV AVAALCON TWV JIOQOPETIKWY TUTIWV
Asitoupyiag tou emeéepyacti ARM (operating modes), ae KABe dla@OPETIKO mode
AEITOLPYIOG TOL ETIEEEPYOTTH), AVTIOTOIXEI KOl SIAPOPETIKO UTIOGUVOAO TOU TwWV
Kataxwpntwv. Mo cuykekpipyéva, KABE dIa@opeTIKO mode Asitovpyiag, «BAETIED,

QVTIAQUBAVETAL KOl SIAQOPETIKO OPIBUO KATOXWPNTWY, AT TOUC 37 GUVOAIKJ, TIOU
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Bpiokovtal atov ene€epyaatry. Me Tov TPOTIO OUTO, TO KABe mode Acitovpyiag, €XEl
otnv d1d0eon Tou, JIOPOPETIKO OPIBUO KaTaXwpPNTwv. To LTTOAOITTIO GUVOAO TWV
KOTOXwPNTwV TIou OV €ival «opaToi» amd 10 KABs mode, OTTOKOAEITAI PE TOV
ayyAIKO 0po “banked registers”. To yeyovog auto anuaivel, 0Tl oo T0 GUVOAO TOV
KOTaXwpnTtwv, KATolol dev €ival TTposPaaciyol amo 1o Kabs mode Asitoupyiag. Ol
KOTaXWPNTEC autoi Tou  dgv  €ival  Ttpoofaaiyol, ovopaldovial  «KPUQoi
KOTOXWPENTES» 1 aAMKC, “banked registers. KABE XpOVIKN) aTiyur] TN AEITOLpYiaC
Tou eme€epyaaTn, TO TPEXOV mode Acitovpyiag Tov, Kabopilel Kal Tov aplBuo Kal 1o
TIOIOl OUYKEKPIPEVA, Ba eival ol TipooPdoiuol, o€ autd To mode Asitoupyiac,
Kataxwpntég. H ovopatoAoyio Kal Twv TIEPICGOTEPWV KOATAXWPNTWV Eival g
HOP®NC rxx, OTIOV TO r AVTICTOIXEI aTNV AEEN register, Kataxwpntng dnAadr), evw Ta
emopeva d00 Yneia, Kupaivovtal amé 10 0 PEXPI Kal TO 10. Emiong, umdpyouv
KOTOXWPENTEG, Ol OTIoI0I €Vvw AKOAOUBOUV TV OvouaToAoyia, €10l OTMwC
TIEPIYPAPNKE TIAPATIAVW, TIEPIYPAPOVTIAlI KOl PE TA OKPWVOPIO TOUC, OTIWG Ol
Kataxwpntég PC, cpsr Kal spsr. X& KABE TEPITITWAON, Kol € OAN TNV SIAPKEIA TNC
Ttapo0oag Epyaaciag, Pe Tov 6po sp register (1 KAtaxwpntig sp), 6a avapepouaoTte
otov Kataxwpnt M3, mou €ival 0 KATaXwPnTNE OV ava@EPETAl OTO OEIKTN NG
stack. Mg TOvV Opo Ir register (1 kataxwpnmg Ir), Ba avagepoyacte oTOV
kKataxwpnt) M4, mou €ival o link kKotaxwpntig, 1Touv O&iXVEl OTNV EVIOAN, TNC
oTtoiag n ektéAeon Ba akoAouBrael PETA TO TIEPAC TNC dlaxeipiong piag eéaipeong
(exception handling). Mg Tov 0po pc Ba avagepouacte atov Kotaxwpnty M5, o
OTIOIOG €ival 0 KOTAXWPENTNC TIOU «OEIXVED, TIOU OVOAQPEPETAl TNV ETTOPEV TIPOG
EKTEAEON €VTIOAN. Ol KOTOXWPNTEC CpSr Kal spsr, Ogv  OKOAOUBOLV TNV
ovouaTodoaia, €101 OTIWC TIEPIYPAPNKE TIAPATIAVW, OAAA OVOPEPOPOCTE GE ALTOVC
HE TO OVOPOTA TOUG KOl Povo. OTwg Ttpoava@eéPBnKe, o€ KABE dIa@OPETIKO mode,
UTIOPOUV VO TIPOOTIEAAOOULV  €VO  OUYKEKPIUEVO OET  Katoxwpntwv. o
OUYKEKPIPEVO KABE dIa@OPETIKO mode Asitoupyiog, €xel TpocPocn o€ éva O€T
KOATOXWPENTWVY OO TOV KATOXWENTH ro €wg Kal Tov Kataxwpnt M2. Emiong kabe
OlaPOPETIKO mode AEIToupyiag £xel va EEXwPIaTo stack pointer register KaBwg Kal
éva EexwploTo link register. Opwc 0Aa Ta mode Acitovpyiag, €xouv pPoaPacn oTov

010 Kataxwpentr pc, Kal atov idlo cpsr. ETmpocteta, oAa ta modes Asitoupyiag,
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TIou dlaBEToLy dIKalwUaTa «UTIEPXPnotn» (privileged modes), TAnv tou System
mode, £xouv TPOaPaacn ae Evav EEXWPIOTO KATAXwWPNTH, TOV SPS.

Mo va yivel akéua 1o Katavontr) n AEIToupyikotnta 1wv “banked registers” katd
TNV SIAPKEIA TNG EKTEAEONC €VOC TIPOYPAUMOTOC Ba Ttapabécoupe T0 akKOAOLOO
TIOPAdEIyUa, TIPIV OUWG, Ba TIPETIEL VA TIPOXWPNOOUUE KAl O HEPIKEC OKOUO
OIEVKPIVIOTIKEG TIOPOTNPNOEIG, OXETIKA PE TNV £VVOIO KAl TOV TPOTIO AEITOLPYiag
Twv banked registers. OTw¢ ava@EPOPE KAl TAPATIAVW, TA OeOOPEVO  TIOU
OVTIOTOIXOUV O€ £vav KoTaxwpent, eV avtioTolXolv Povo Je Bacn Tov aplbuod tou
KOataxwpntr], aAAa Kal e Bdon 1o mode Asitoupyioag oto omolo Bpioketal ekeivn
TNV OTlyul o eme€epyootc. EmmpocOeta, o1 TIPEC TwV METABANTWV TIOU
Bpiokovtal 0Toug «KPLEOULC», I} aAAIWC oToug “banked registers”, dev aAAG{oOLV Kail
TIOPOPEVOLY OTOBEPEG OOEC PETAANAYEC OTO mode AEIToupyiag Tou ETeEepyaaTn
Kal av €xoupe. METa amo AUTEG TIC OTIOPAITNTEC ETUTIPOCOETEC JIEVKPIVIOTIKEG
TIANPOPOPIEC, UTTOPOUME VA dWOOLUE EVa TIAPASEIYHA, WOTE VA YiIVEL TIIO KATOVONTO
Kal «oTtnv TIPA&n», n Asitovpyia twv bakned registers. @ewpoOUE AOITIOV, TIWC

€XOULUE TOV ETIEEEPYATTA HOC, VO AEITOVPYEI 0TO user mode.

Tpéxovteg TIPOCRACIUOlI KATOXWPNTECG
i0
rl
r2
3
r4
5

User Mode

Banked Register

ré FIQ IRQ SsvC Undef Abort
r7
rS rs
ro tv
rio rlo
rl! ill
ri2 ri2
rI3(sp) ri3 (sp)
ri4 (ir) rl4 (Ir)
r!'5 (pc)
cpsr
spsr\ spsr spsr spsr
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210 mode autO AOITIOV, 0 ETIEEEPYAOTAC OTIOONKEVEl TNV TIU MPNoev (0) aTov
KOATOXWENTH TO KAl TNV TIUN oKTw (8) otov Katoaxwpent r8. MEta amod autr tnv
EKTEAEON, 0 eméepynoTtr)¢ aAAGlel mode Asitoupyiag Kal oo TOo user mode,

METOTINOAEL Kl ouve)ilel va Asitovpyél o€ FIQ mode.

"Opatoi” - MpooBdociuol Kataxwpnteg

FIQ Mode 10
rl

v2
V3 Banked Register
!

v5
r6
v7
tS

19

rlO

il

rl2

113 (sp)
r14 (Ir)

User IRQ SvC Undef Abort

>10 FIQ mode AoITtOV N TIPA TOU KOTaXwPnTn ro, €ivail n idla pe TNV TN 1ov €ixe
KOl 0 KATOXWPENTNAC ro aTo user mode, KOBWC £XOVPE aVOPEPEL TIAPATIAVW TIWC OTO
FIQ mode, €xouue IPOCRACN OTOULG KOTAXWPENTEC aTto r8 pEXPI Kal M2, ETopévwg,
uTtoBETOoVTOG TIwC 0To FIQ mode, yivetal amoBnkeuon €K VEOL Kal oToug O00
KATOXWPNTEG ro KAl r8, TNV TIN 1, €AV aAAAEEL Kal TIAAI TO mode Asitoupyiag Tou
ente€epyaatr) kal amd 1o FIQ mode petamndrjocouvue Kal TIAAI aTo user mode, TOTE Ol
OTIOBNKEVUEVEC TIMEG OTOUG KATOXWPNTEG ro Kal r8 Ba eival 1 kKal 8 avrticToixa.
AuTO oupPaivel ot oto FIQ mode, o0 emeepyaotr)c €xel TPocoPacn o€
KATOXWPNTEG ATIO 8 PEXPI KAl M2, KAl OXI OTOUCG ro PEXPL Kal XN, ETIOPEVWC U
oAAayr oTa dedOPEVA AUTWY TWV KOTOXWPENTWY, Ba dlatnpenoel Kal Ba TIPOKOAECEI

HOVIUN aAAdyn Twv 0ed0opévV Kol aTa UTIoAoITTa modes Asitoupyiac. Avtifeta,
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OTOUC KOTaXwPNTECG v8 -M2, o1 oTtoiol gival «opdtol», aTo mode Asitovpyiag FIQ,
Ml oAAayn ota 0edopéva Toug, Oev Ba TIPOKOAETEl AAAAYN OTOUC OVTIOTOIXOUC
KAToXwpPNtéC Tou user mode, KaAB'OTl €T TNC oOuCIOC AVAQPEPOUOOTE OF
OlO@OPETIKOVG KATOXWPNTEG, OIOTI OTIWG EiXE avOEEPBEI KAl TAPATIAVE EVaC
Kataxwpntrg ,0ev dlakpivetal pévo amd TNV OVOUOATOoAoyia Tou, aAAd Kal ot TO

mode Touv €TeEEPYATTH], GTO OTI0IO AEITOVPYEI.

Mopakdtw TIaPATIBETal TO OXESIAYPOAUUO  KATOVOMPNCG Kol 0pyavwaong Twv
KOTaXwpntwv tou emegepyactr) ARM, avdloya pe T0 OVOUG TOuG Kal pe To mode

AEITOLPYIAC OTO OTI0IO AVIKOULV.

Supervisor Abort |RO Undefined
no no no
R1 R1 R1
R7 H2 r?
R3 R3 FU
R4 R4 R4
I RS RS
m R6 R6
H7 R7 «T
HB Ha
no m R®>
mo mo RIO
mi H1l Mil

R12 R12 H12
A.nuc AR13 »it A~ RI13irq

AR14-svr A RL4-r|
s15=pes  [IR15(PC) R15 IPC)

CPSR CPSR CPSR CPSH CPSR
NSPSR-tiq NSPSR-it<|

* t>»nk*4 regUtfT

tPSW m St»»» Proofan» Status fleaislet
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Mvwplpia pe v mAat@opua X-board

MPOTOL TIPOXWPNOOULUE GTNV AVAAUCT TWV EPAPUOYWV TIOU AVATITUEAPE TLVETO Ba
TaV va TIPOXWPNOOUKE GTNV €K BaBEwv yvwpidia Ye TNV TTAATQOPUA, TTAVW OTNV
oTtoio avaTItuXONKe N EQapuoyr).

OTw¢ ava@EPONKE KAl TTAPATIOV®, N TIAOTQOPKA TIOL XPNOIKOTIONNBNKE TIPOEPXETAI
aTo v staipeia ADI, kail TiepiEXel Evav emegepyaaotr] Intel XScale, apXITEKTOVIKNAG
ARM. Ztnv MAAT@OpUO auTr, €V AVATT'TUXONKE N €@apuoyn, 0AAa PE Baon auty,
N €EAPUOYN HAC OXEOIAOTNKE KOl EKTEAECTNKE. H €@OpUOyr HOC LAOTIOINONKE
TMAvw O€ €vav amA0 - KOIVO TIPOOWTIIKO NAEKTPOVIKO uTtoloyiot (Personal
Computer, PC). Mapakdtw emeényovye, mwe YiveTal n dladiKaaia ETIIKOIVWVIAG Kal
EMPAVIONG TOL ATIOTEAECHATOC MIOG TIOAD OTTIANG EVIOANG, omwg n printf(“hello
world \n"); Auto mou cupBaivel givail 1o €€nc:

KatoapxrVv 0 TIPOCWTIIKOC NAEKTPOVIKOG LTIOAOYIOTAG Wag, TIAVW CGTOV OTIOI0 YiveTal
N QavATITuén TNC €@APPOYNC Hag Agyetal host computer, evw n TAATQOPUA
eTideI€ng Kal ekmaidevong Tov XScale, MAvw oTNV oToia Ba TPEEEL N e@apuoyn
hag, Aéyetal target computer. AUTO oL AaUBAVEL XWPO AOITIOV, €ival OTI KOTA TNV
OIAPKEID TNC EKTEAEONC MIOC €VIOANG, yia Ttapadelypa tng: printf(“hello world
\n");, o target computer, n TTAATEOPUA dnNAAdN TIPOCTIOBE va «avayvwpioe» TNV
AEITOVPYIKOTNTO NG CLYKEKPIPEVNC EVIOANC. Mo va To €TUTOXEL OLTO, ATIOPAITATN
mpo0Toebeon e€ival va €xel mpdéofacn o target computer, OTOV TIPOOWTIIKO
UTIOAOYIOTH, Kal EI0IKOTEPA GTO GUVOAO TwWV BIBAIOONKWY TIOL XPNCIYOTIOIOLVTAI
armd Tov host computer yia tnv avdmtuén ¢ €QApUOynG. AEDdOPEVOL TOUL

yeyovoto¢ outol, o target computer, dNUIOLPYEI MIa SIAKOTIH AOYIOUIKOD, &va
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software interrupt (SWI), 10 omoio Kal otéAvel otov host computer. To software
interrupt, 10 Jdlaxelpietal évag Tpaktopac (agent) Tou P'plOKETOl OoTov host
computer Kol ETIIOTPEPEI TO ATIOTEAECUO TNG EVIOANC OTnVv 060vn ToL X'PNoTn,

atov host computer.

AyyeAol Kal Adioveg

H mAat@opua tepdapBavel kail Vo oToIxXEia Ta o100 cLVEPYALoVTal PIETAEL TOUC
Kol KaBopidouvv v avtoAAayn twv dedopévwv PeTagld twv host kal tou target
computer. MNa va yivel n mopamdvew SladIKacia Kal va LTIAPEEl TIPAYHATIKA
ouvepyaaio YETAED TNC TIAATQOPPOC KOl TOU UTIOAOYIOTH] OTOV OTIoio AdpPBAVEl
XWPA N aVATITLEN NG EQappoyNC. Tnv dladikaaia avtr TNV avoAauBdavouy autd Ta
dLo oToIxéla, o Aaipovag (Debug Demon) kai o Ayyehog (Angel).

O Aaipovag, Bpioketal atov target computer, otnv TTAATQEOPUA dNAOdH ETTAVW Kal

gival oxedlaopévog eE0AOKANPOL oo v idla Tnv ARM, TNV KATOOKELACTPIA
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etaipeia tou emegepyaoty ARM. Eival vAomoinpévog oe assembly, oe yAwooo
pNXavAg onAadn, Kal ylo TNV ETIKOIVWVIO Tou Pe 1o PE tov host computer
XPNOIUOTIOIE eva TIPWTOKOANO byte-streaming (por¢ dedopévwv, ava byte). Autod
TIou dloo@aAilel 0 Aaipovag €'val T0 yeyovoc OTI 0 KWAIKOC TIOL avaTttuxOnke amod
Tov efopolwt) Tou emegepyaotry ARM, mou umtdpxel otov host computer, ToV
ARMulator, 6a eKTEAEOTEI KOl OTNV KAVOVIKI]  TIAAT@OpPO Tou ARM, Kal o€
KOAVOVIKO eTte€epyaatr) ARM dnAadn Kai 0xl yévo o eE0UOIWTH.
O AyyeAog, Angel, XpnoIJoTIoIEiTal IO VO KAVEL TNV PETATPOTIN Twv OEQ0UEVWV OE
YAWOOO PNXavig, 0€ POUTIVEC NG YAWCoOC Tipoypappatiopol C. H emikoivwvia
TOU pe Tov host computer, €TUITUYXAVETAlI PECW METAPBANTOL MEYEBOUC TTIOKETO
oedopevwy (variable-sized packet-based communication). Emimpoobeta, o Angel,
uTtooTNPICEl Kal 0dnyolC €EWTEPIKWV CLOKELWV (external devce drivers), OTwC
Ttapadeiypatog Xapiv, 0dnyolg yia pia cuokeun TOTtiKoL dikTuou (Ethernet).
O Angel, attoteAeital amo 2 pépn:
> Tov Amaoc@oaApotwtr¢ (Debugger), o oroio¢ ekteAeital mavw otov host
computer Kal 0 0OTtoiog divel TIC €VIOAEC otov Angel kal gpgavilel ta
OTTOTEAECUOTO KOl TOV
> Angel Debug Monitor, To omoio €ival €vag éAeyxoC AmOC@AAUATWONG TWV
TIPOYPAUHATWY KAl 0 OTI0I0C EKTEAEITAI OTOV target computer.
> Télog, vumdpxel kair to Angel Debug Protocol (ADP) , 1o oToio
XPNOIUOTIOIEITAl YyIO TNV ETIIKOIVWvia, PeTaéd tou host kol Tou target

computer, HETAEL TOL TIPOCWTIIKOVD LTTOAOYICTH YoC dnNAadn Kail tou X-board.

METa amo OAa auTd, i0wWC KATIOI0C VO avapwTnOEl, TI TIPpAyUATIKA KAavel o Angel; H
armavinon €ivar 6t o Angel TIPOYUATOTIOIED PIa CEIPA ATI0 EVEPYEIC KATA TNV
SIAPKELO TNE OPXIKOTIOINGNG KAl TNG €KKivong Tou ouaTtiuatoC. Mo cuyKekpipéva
0 Angel, kata Vv JdIAPKEID TNG @ACNC €KKivNoNng Kol OpPXIKOTIOINONG TOu
eTteEepyaaTr), TIPOPAIVEI OTIC OKOAOLBEC EVEPYEIEC:

> T[pofaivel oTnv BacIKr apXIKOTIOINGN TOL £TEEEPYATTA KOl TOU GUCTHMATOG

(X-board).
> Anuiovpyei pia evtoAn diakAddwaong (branch) otnv apxr tng pvrivng ROM,
> EAeyxel 10 péyebog ¢ pviung RAM,

23



> doptwvel dedopéva amo tnv ROM, otnv RAM,

vV

ApXIKOTTOIEl TOLG dlaXEIPIOTEC TwV dlakoTiwy IRQ Kal FIQ

> Apxikotolei ta omoia LED (pwtevoi KpOGTAAAOL) LTIAPXOLV  OTNV
TIAOT@EOPHA ETTAVW.

> ApXIKOTIOIEi Kol KaBapidel oo ta Tlavov dxpnota ded0uEVA TO KAVAAL TNG

armtoc@oAuatwong (debug channel) petagd tou host kai Tou target computer,

KOl TEAOC TIPOXWPEI TNV EvEPYOTIOINGN TwV dIOKOTIWV (interrupts)

MevikOteEPa, 0 Angel, TIPOO@EPEl Pl TTANBwpPa armo duVOTOTNTEC, Ol OTIoieC Ba
avVaAUB0oUV TIOPAKATW, OTIWC:
> APXIKOTIOINGN TOL CUGTHUATOC
> [Mapoxn AEITOLPYIKOTNTOG GAV VO ETIPOKEITO YO AEITOUPYIKO GUOTNUO
> Ymootpign BiIBAI0BNKWY TNG yYAWoaoag TTpoypappatiopou C.
> Amoo@aAudtwon (Debug) otov Kwdlka Tou TpoypdpuatoC. H teAsutaia
auty duvaToTNTO TIOPEXETAl PECW TNC OLVATOTNTAC VO (@POPTWVEI TO
TIPOYPAUUA, TO EKTEAECIUO TIPOYPOUUD, oTtO Tov host computer otov target
computer, Kal JE TO VO LTTOCTNPI(El ONnUEia dIOKOTING TWV TIPOYPOUUATWY
(breakpoints).

Mo CUYKEKPIYEVA, KOl 000V a@opd TNV dLVOTOTNTO OTTIOCEOAUATWAONG Tou Angel, 0
Angel umopei va vTtootnpiéel BacikeG AEITOLPYIEC OTTOGPOAUATWAONC, OTIWC:

H petag@opd tou mtpoypappatog (program downloading). Me authy Tn Asitovpyia o
artac@aApatwtig (debugger) mou Bpioketal otov host computer, OTEAVEL pia
oAANAovXia attd dedopEVA Kal Pnvopata e Baon to TIPWTOKOAO ADP stov Angel
TIou BpiockeTal TOvw oTo target computer.

H oploBétnaon onueiwv d1akoTiNg ekTEAeoNC Tipoypaupotog (breakpoints setting).
Me Tnv Asitovpyia autrd, o Angel, XpNOIUOTIOIEI PN OPICUEVEC EVIOAEC YAWOGCOC
punxavr¢ (undefined instructions), yia va vmootnpi€el Ta breakpoints. ATO tnv
oTiyun mou Ba opoBetnBei o breakpoint, o Angel, Ba Ttpoei o€ dVo evEPYEIEC:

Oa amobnKeVLOEl TNV EVIOAN, OTNV OTIoIa TTAvw YiveTal To breakpoint, €101 woTE va
Ol0C@OAICTEL OTI N KAVOVIKI EKTEAECT TOU TIPOYPAUMATOC Ba ETIICTPEPEI OE EKEIVO

OKPIBWC TO anpeio Kal 01 TTouBevd aAAOL PETA TO TTEPAC TOL breakpoint Kail
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AVTIKOBIOTA TNV €VTOAN PE PO KATAAANAN U OPICUEVN EVIOAN
TéEAOg, 0 Angel, n KAVOVIKI] EVIOAN ETTOVOEEPETAL KOl EKTEAEITAI KAVOVIKA, OTAV
opwC¢ o breakpoint agaipeital, 1] OTav N EKTEAECT TOU TIPOYPAUUOTOC GUVEXIZETOI

aTo T0 onuEio Tov breakpoint Kai PETA.

Ocwv 0Qopa TwPa TNV duVATOTNTA, TIoU €XEl 0 Angel, GTov XEIPICUO Kal OTnv
olaxeipion Twv onueiwv dIOKOTIAG TNG KAVOVIKNG EKTEAEGNC TWV TIPOYPAUUATWY
(breakpoints handling), o Angel pog Ttapéexel Ta €€Ng:

Otav o Angel, evioTticel pIa €VIOAN, n oOToiod va e€ival éva amo  Tplv,
TIPOKOBOPICPEVO ONUEIOBIOKOTING EKTEAECTC TOL TIpoypduuatog (breakpoint), 101e
0 Angel:

1) AIOKOTITEI TNV EKTEAEDT) TNG EQOPUOYNC OToV eTegepyantry ARM,

2) ATIOOTEAEL €va Prvupa oTov host computer, WOTE va TOV EVNUEPWEL KAl
va tou uTtodeigel oL akpIBwC Bpioketal To breakpoint,

3) EKTEAEL HIO «OLOTNPN» KAl «T@IXT» ETTAVOANTITIKY dladikaoia (tight
poll loop), oto0 onueio akpPIBWCG €KEIVO KAl avVOUEVEL OTtavinon omd tov host
computer.

Edv 0pwg n evioAn dev gival eva mtpokaboplopévo breakpoint tote 0 Angel:
Ava@Epel TO yeyovog autd otov Debugger kal To ava@EPEl WG IO U OPICHEVN
EVTOAN Kal

EKTEAEL MIO «QLOTNPIP» KAl «OQIXT» €TTOVAANTITIKY dladikaacia (tight poll loop),

OTO OnNUEio aKPIBWC EKEIVO KOl OVOUEVEL ATIAVTNGON amo Tov host computer.

OAOKANpwvovTag TNV &votnta auth yia Tov Angel Kal TPV TIPOXWPIOOUUE
TIOPOKATW OTN AETITOUEPH TTAPOUCiacn Tou X-Board, YmopoluE va ava@EPOUE EV
OAiyol¢ Ta akoAovBa yia Tov Angel:

Zav apxn, avag@epOuacTe OTIC dIO@OPOTIOINCEIC Tou Angel o1 oTtoieg gival
o0o: o Minimal Angel kot o Full Angel. O Minimal Angel Tmapéxel povo
OPXIKOTIOINGT TOL CLUCTAUOTOCG PAC KOl TITTOTa AAAO, €V avTiBEael pe tov Full Angel,
0 OTIoio¢ TIEPA OTO0 TNV OPXIKOTIOINGN TOU GCUCTHMOTOC TIOU TIPOPEPEL HOG
TIPOOPEPEL KOl UTTIOOTAPIEN Twv PIBAIOONKWVY TN¢ yAwooag C, OTwG £TTioNg Kal

ALVATOTNTEC ATIOCPOAUATWONG.
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0V OLVEXEID VO OVAQPEPOUVE TO YEYOVOC TIWE N SLVOTOTNTA ATIOCPOAUATWAONC TOU

Angel XpNnoIUoTIoIEITAI HOVO KaTa TNV SIAPKEIN TN AVATITUENG TOU GUCTUOTOC.

Kal peTd amd v avake@oAaioon twv duvatot)twv Tou Angel, pmopouvue va
TIPOXWPNOOULKE OTNV TIapoLaiacn Tou target computer, TN¢ TTAATEOPHO AVATITUENG
NG EQapuoyng pag, To X-board.

AVOAUTIKI Tteplypagr) tou X-board

Onwg ava@epbnke Kal Tapomdvw, To X-board, OTOTEAEl MIA  EKTIAIOEVUTIKNA
TAOT@OPUO  aVATITUENC  E€QAPUOYWV  YIA EVOWHATWUEVA  ouoThuata. H
KOTOOKELAOTPIa eTaIpEia eival n ADI, v EVOWPOTWVEL ETTAVW TOU Tov embedded

eme€epyaotn XScale ¢ Intel. H popen tou X-board givai n akoAoun;:

KouuTti eTtavekkivnang

duoikd, to X-board, cav TAnpng embedded LTTOAOYIOTIKY TIAATPOPUA, dVVOATAL VO
(PEPEL ETIAVW TOUL, KOl ETUTIAEOV OUCKELEC TIOU Ba TNV KAVOLV VO LTIOCTNPIEEL
TIOPATIAVW KOl ETUTTAEOV SLVATOTNTEG, OTWC YIO TIAPAdEIYUO HIO KAPTO NXOL Yl
NV Ynelakn emegepyooia dedOUEVWV QWVAC KAl NXou N €va apIOunTIKO
TIANKTPOAOYI0, VYIO TV UuTooTtipi§n Twv POCIKWV €EVIOAWVY €10000V OTO

EVOWUOTWHPEVO GUCTNUA, OTIO TOV XPROTN TOL CLCTHMATOC, ATIELOEING og ALTO Kal
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XwpPI¢ va pecoAafei 1o host computer. Zta TIAQicIO TNG EPYACiag aUTHC, KAl TNG
EQAPMOYNC N oTtoiag avaTtuXOnKe, XPNOIMOTIOINONKE N GUOKELH TOL APIBUNTIKOU
TIANKTOAOYIOU, QWTOYypa@ia TNG OTIoIOG TIOPATIOETAI TIOPAKATW:

MAov, N TIAQT@EOPUA HOC, YE OUVOEDEUEVO TO APIBUNTIKO TIANKTIPOAOYIO €XEl TNV

TIOPOKATW HOPQr).
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Ta Boolka pépn NG TAATEOPUAC OUTAC, PEPN TO OTIoiO UTTOPEL va Ta JIaKPIVEl

KAVEIg d10 yupvoL o@BaAuoU gival Ta akoAouba:

Power Supply

Seven
Segme
Display

Boot Ima
Selector

H TAQT@Opua TIAVW OTNV OTIOIO TIPAYHATOTIOONKE N JITIAWUATIKY €PYACia Kal
OTNV OTIOI0 ETAVW EKTEAECTNKE 1 €@APUOY OIOOETEL TO OKOAOUBO TEXVIKA

XOPOKTNPIOTIKA:

EmegepyaoTnq XScale - based Intel 80200 @ 733 MHz
Mvriun SDRAM 128MB @ 100MHz

Mvrun Flash 4MB, 100 - 150ns

Ethernet - 2 Ports 10 /100 BaseT

Serial - 2 Ports RS232,115200K

OTw¢ ava@éPBNKe Kal oTa TEXVIKA XOPOKINPICTIKA TNG TIAATQOpuag, To X-board

olaBgtel pvun tomou flash. Mpoxwpolue aUEcwC TIOPAKATW OTNV TIEPIYPOQT)
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autol TOU €idoUC NG YVNUNG KAl OTO TIwC auTH Eival opyoavwuevn oto X-board,
KOB'OTI N AEITOLPYIKOTNTA TNE, XPNOILOTIOMONKE 0TV aVATITLEN TNG EQPAPHOYNC.

H flash memory eival évag t0Tog pvhung, pn €LPETABANTN (non-volatile), tng
oTtoiag Ta dedopéva gival duvatdv va afnotolv Kal n idla n pvnun ival duvatov
VO ETTOVOTIPOYPOUUATIOTEL NAEKTPIKA. O pvrueg tomou flash amoBnkelouv Ta
oedopéva ae PmAok. ‘Etol Aoimtov €av BEAovpe va ypagouue i Kal va dlaBAacoupe
OTIO PIA YVAUN TETOIOUL TUTTIOU dedOPEVA, AUTO Ba Yivel ava Eva 1) ava apiBUO PTTAOK
TNV KAaBe @opd. To X-board diaBétel 4MB pvrung tomou flash, n otmoia eivai
OlOXWPIoHEVN a€ dUO AOYIKEC CUOKEVEC:

H pio amo TI¢ U0 AOYIKEC OUCKEUEC OTIOTEAEI TO TUNAMPO «@POPTWMATOC» TWV
TIPOYPOUPATWY otnv pvAun (boot portion), kai TtepIAauBavel 1o boot monitor, 10
OTIOI0 OTIOTEAEI TOV «EAEYXO» KOl TNG OIASIKACIOG «@OPTWHATOC TWV APXIKWV
TIPOYPOUUA' TV OTNV VAN, Tov TEAdTn (client) touv amoo@oAuatwt) Angel
KOBwWE Kal KATIOIO apxeia T oToia XpnolpoTttololvTal yia va K'VEL TECT T
0edopévVa TNE PvRuNg Kabwg kat Ta dedopéva Tou boot monitor, 1o idlo to X-board.
H deUTeEPN AOYIK] GUOKELN Eival TO PEPOC TNG UVAMNG TIOU XPNOCIYOTIOIEITAl YIO TNV
OTIOBAKEUOTN TWV EQPAPMOYWV OCE OUTAV. Z€ QUTO TO MEPOC TNG MVAUNG,
OTIOONKEVETOI N TIPOG EKTEAEDT EQAPMOYH HOC.

high memory
Footer

Unused

Image Information

Header

Ullage A1Co

low memory

210 onueio auvtd Ba TIPETIEI VO TOVIOTEL TO yEYOVOG OTI eV ETUTPETIETAI OE KOUIA

TIEPITITWON VA 0picel 0 Xprotng tou X-board, w¢ «e&'oplopol» TopEa TG PVAUNG,
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TOV TOMEQ TOU boot portion, KaB' OTI TO YEyovOC aUTO Ba KOTEGTPEPE OAOKANPWTIKA
TNV PvAUN Kat Ba Atav adlVOTo Ao €KEl Kal 010 €ENG VA EEKIVIOEL VA AEITOVPYEI N
TIAOT@OpUa X-board, kabw¢ Ba éoBnvav ta dedopéva Tou boot portion Kai dev Ba
rtav va mpooTieAdoouy Ta dedoueva autd amo 10 X-board, pe amotéAeoua va unv

MTTOPEi va eKKIVNOEi Kal va apXIKOTIOINOEI T0 OA0 EVOWHATWHEVO GUATNUO.

Onw¢ @aiveTal Kal TNV TIaPaTtdvw @WTOYPAPIa TIOL AVAPEPETOL TNV 0pYyAvwaon
¢ pvnung flash, mou Bpioketal gto X-board, diakpivoupue TIC €€NG TIEPIOXEC -
TOEIC;
> Image area: ATIOTEAEI TNV TIEPIOXN TNG VKNG OTNV OTIoia artobnkevovTal
OMAOC 0  KWAIKAG KOl T TUAMOTO  OedOpEVO  TIOU  PTIOPOUV  va
XpnolpoTtoinolv povo yia avayvwaon (read-only data segments)
> TIAnpogopie¢ EmkepaAidag (Header Information): Zto tuRua outo
artoBnkevovtal 0Aol o1 HEBAPRNETIIKEPAAIDEC) TwV apXEiwv TOL €XOLV
@opTwWOEi amo Tov host computer, oto X-board.
> |mage Information: Zto TUUa Autod aroBnkeLovTal TO Gvoua TOL image,
KOBWC Kal Ta XapaKtnpIioTiKA Toe(image identification - image name)
KOBWC Kal Ol AEITOLPYIEC TOL KWAIKA, Ol OTIoIEC TIPOCTIBEVTAI EKEl aTIO TNV
BiBAI0BNKN NG flash pvAung.
> Mn xpnolgortoinuévn pviAun (Unused flash): Topéag t¢g pvAung mou dgv
XPNOolJoTIoIEITal.
> TMAnpogopieg Footer (Footer Information): Me tnv €vvoia footer, gvwooUuE
TO OTOTUTIWUO TIOU A@nVel n pvAun. O1 TAnpo@opie¢ auvtég tou footer
TIEPIEXOLV:
> Tnv d1E0BLVCT TOL PTIAOK TNC TIANPOQPOPIOC VIO TO CUYKEKPIUEVO image TG
HVAUNG.
> Tnv dlevBuvaon Baong (Base Address) yla Ta dedopéva
> Mia pyovadika 32-bit iy}, n omoia pog xpnolpevEel atnv ypriyopn avalntnon
TV OeO0UEVWV, HECO OTNV YVAUN.
> O t0mog Touv Image. AnAadny ptopEel va sival T0TToV UTIAOK, TOTIOL image,

T0TI0V SIB, TOTIOUL OEDOUEVWV.
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> ABpoiopa  eAéyxou(checksum), yia Tnv  €yKLPOTNTA KOl TNV

OKEPAIOTNTA TOV 0€A0UEVWV TIOL BpiokovTal oTo footer.

Onw¢ apouaoidoape Aiyeg TTapaypa@oug Tpiv, 1o X-board, S100£TEl VO CEIPIAKEC
B0peC, OTIO TIC OTIOIEC N Hiol XPNOIYOTIOIETAL YIa TNV 0UVOECN KOl TNV ETTIIKOIVWVIO
ToL X-board pe Tov LTTOAOYI0TH, TOV host computer, Kal n GAAn XPNOIUOTIOIEITAl YIO
TNV olvdeon Tavw oT0 X-board, €EWTEPIKWY, TIEPIPEPEIOKWY CUTGKELWV.
KaBiotatal ca@ég Ot n Xprion g oEIplaKng BUpag Kal N yvwan tng AEIToupyiag
TNC €ival KATI TTOPATIAV® OTIO ATIOPAITNTA YIO TNV AVATITUEN TNC EQPAPHOYNC HaC.
MpoxwpoLWE AOITIOV GTNV aVOADCT TNG AEITOVPYIAC TNG OEIPIAKAG BUPAC.
H oeipiokr) 60pa, XPnOIUOTIOIEITAl yIa TNV OCEIPIAKN ETTIKOIVWvIa pPeTay duo
UTTOAOYIOTIKWV CUOTNUATWY KAl TNV ovioAAayr] Oedouévwy HETaED TtouC. H
XPNOIUOTNTA TNG KAl 0 TPOTIOG UAOTIOINONG KOl AEITOLPYIKOTNTAC NG, TNV
KaBIoTOUV ONUAVTIKOTATO TPOTIO ETIIKOIVWVIOG. AUTO TIoU AaUBAvVEl XWpo OTNV
oeIploKr Bupa gival 0TI oTéAvovTal Kal AauBavovtal dedopeva Tou evog bit, tnv
KABe @opd, MAvw oto KABe kaAwdlo. Mapd 10 yeyovog TwC XPEIALOVTal OKTW
XPOVIKEC OTIYUEG YIO VO OTOAEL eva byte, ka®' 6cwv yvwpilovpe 1 byte = 8 bits,
Xpelddovtal POAIG Aiya KOAWIIO yia va €TUTELXOEI OUTO. Z€ PIA TUTTIKI) CEIPIAKT)
ETUKOIVWVIa, aTtaItouvTal TPia, HOAIC, KaAwdia. ‘Eva yla v aTocoToAn Twv
0edopEVWIV, €va yia TNV ANWN Twv dedoPEVWVY KOBWE Kal £va KOIVO KOAWDIO, TO
OTIOIO XPNOCIUOTIOIEITOI GaV Yeiwan.

MapakATw, TTOPATIOETAl Yo ATTAOIKN ATTon TOu TPOTIOL AEITOLPYING TNC
oeIplaKng Bupac.
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ATIOOTOAEQC MapaAnmng

AUTO 1oL AauPBAvel XWpa, gival TO yeyovoc OTI JIaBETOLE dVO KATAXWPNTEC, TOV
KOTOXWPENTH  EKTIOUTINC OEOOUEVWY KOl TOV  KAtaXwpnt) ANWng OedopEVWY
(Transmit register - Tx, Receive register - Rx). Autd Tou cupPaivel gival 10
YEYOVO( ¢ KABE popd Tou 0 Ty ival adelog, dnuiovpyei pia diakotr (interrupt),
onuaivovtog nw¢ 1o byte mou Tav amobnkevuévo oto buffer Tou, ameoTtdAn Kai
TWPO €ival £ETOINOG VO TIPOXWPHOEL OTNV ETIOUEVN OTIOOTOAN byte Tipo¢ To receiver.
OTw¢ ava@EPAPE Kal TPV, KABE XPOVIKY OTIyr], YETAQEPETAl Eva bit, kal autd
Qaivetal KaBapd aTnV TAPATIAVW EIKOVA, OTIOU O€ 8 XPOVIKEG OTIYUEC OTIOOTEAETAI
éva byte.

YTIAPXOULV TIEPITITWOEIC KATA TNV JIAPKEIN TNC OEIPIOKAC PMETAdOONC TIOU UTTOPEI TA
oedopéva va xaBolv. AUTO PTtopeEi va yivel ag 300 TIEPITITWOEIC:

A) Edv o transmitter &eKivrjoel TNV €MOPEVN YETAOOON TOL €TOUEVOL byte,
TIpoToV 0 receiver va TIPOAAREl va emeéepyaoTei | kal va dlaBdoel to byte mou
MOAIC éAae aTto TOV transmitter.

B) Eav 10 emduevo, Tpo¢ petadoan, byte, poptwOei otov transmitter tpotol
10 TPEXOV byte TTov peTadideTOI VO TIPOAAPEI VO ATIOCTAAEL.

Mo toug 000 TOPOTIAVW AOYOULC, Ol TIEPICOTEPEC CEIPIOKEC BUPEC XPNOIUOTIOIONY

FIFO buffers, €101 wote va dlaog@aiicouv 0TI dev Ba xabolv ta dedopéva. ‘ETal

AOITTOV XpnaoiyoTtololvtal buffers kai otov receiver aAAa Kail otov transmitter. Ztov
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receiver, XpnolJOTIOIOLVTAl YIO VO ATtoBNKeLOVTAl, WOTE VO WPTIOPOUUE va Ta
eTEEEPYOOTOVUE OPYOTEPQ, EVW GTOV transmmiter yia va HeTadoBouv apyotepa.

To TapoKATW oxnua d€ixVvel TIOAD ETIEENYNMOATIKA TNV AEITOVPYIO PIOC CTEIPIKONAG
ETUKOIVWVIaG, pe TNV xpron FIFO buffers kol otov transmitter, aAAo Kal oTov

receiver.

YTtdpxouv 000 SIOQOPETIKOI TUTIOI CEIPIOKAG ETIIKOIVWVIOG. O €vag TUTIO¢ €ival n
olyxpovn ETTIIKOIVWVIa Kal 0 GANOC givail n aclyxpovn ETTKOIVWVIa.

Me tov 0po OUyxpovn ETIIKOIVWVIO €vvooUPE OTI OAa Ta bits mouv petadidovral,
pETadidOVTAI ouyxpoviouéva, pe Bdon €'va Kolvo onua poAoyiol. Emiong, yia va
ETTITELXOEI ALTOV TOUL €idOULC N ETTIKOIVWVIA ATIAITEITAL Ol U0 CUOKEVEC VA EXOULV
OPXIKO GUYXPOVIOTEI HETAED TOUC, KOl VO GUVEXIoOULV VO OTEAVOLV dedOUEVA PETAED
TOUC, YylOo 000 XPOVOo E€ival cuvdedeeVOol HPETAED TOUC, WOTE VO TIAPOUEIVOLV
OLYXPOVIoUEVOL. To TIPONYOLUEVO, LTTOBNAWVEL TIWC OKOPO Kol OTaV OEV LTIAPXOLV
0e00UEVA VIO POTEPOPA ATIO TNV HIO CLUOKEDN OTNV GAAN, Ol d00 CGULOKEULEC Ba
ouveXioouv va oTEAvouv OedopEVa, KevoUC XOPOKTNPEG yia TNV akpiBela (idle
characters), ®OTe va TIOPAPEIVOUV CULYyXpPoOVIouéveG. H olyxpovn petadoaon
TIPOCPEPEL PEYOADTEPEC TaXVTNTEC PETAdOONC OEDOUEVWY, KOB' OTI dev aTTaITEl TNV
OTtapén emmAgov bit, yia va utodnAwBei €101, aTNV GAAN CUCKELN N €VapPKN KAl N
ANEN TNC petadoaong Tou KAbe byte.
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Me TOV 0p0 aclyxpovn HETAdOACN, €VWOOUME OTI KAOE OUOKEUN XPNOIUOTIOIEL TO
OIKO NG POAOI, Kal Pe BAon outo Ta OedOopEVA ATIOCTEAAOVTAL AUTO €XEl WG
OTIOTEAECUA N HETAdOON TwV OedOUEVWVY, OTO TNV MIA CUCKELH OTnV GAAN, va
yivetal oe avuBaipetoug XpovouC. e QLT TNV TEPITTIWON AoITOV, avTi vad
XPNOIUOTIOIWPE TA  POAOYID TwWV OUCKEUWV, YIO TOV GUYXPOVIOUO TOUG,
XPNOIUOTIOIOVUE PIO GUYKEKPIUEVT aAANAoLXia dedopEVWY, N oTtoia av An@Bei amd
TNV OUOKEUN TTOPOAATITNG, LTTOANAWVEL TNV €vapén | Vv AREn TN Petddoong Twv
oedopévwv. KAgivovtag, 0cov a@opd Toug TUTIOUC TG OEIPIOKNC ETTIKOIVWVIAC,
TIOPA TO YeyovoC OTI N acUYXPOVOC ETTIKOIVWVIO gival EAAXIOTA TO apyn OTO TNG
oLYXPOoVvN ETIKOIVWVIA, EXEI TO TIAEOVEKTNMA, TIWC 0 TIEEEPYNOTIC LTIOXPEWVETAI VO
OTIACXOAEITAI PE TNV ATIOCTOAN Kal APn Twv KeEvwv xapoktipwv (idle characters),
OTIWC OKPIBWC YIVETAI OTNV GUYXPOVN ETIIKOIVWVIA.

Ol oeIploKEC BUPEC IOV GLVOVTA KAVEIC OrUEPA GTOUC TIPOOWTIIKOUC UTIOAOYIOTEC,

LTTOOTNPI(OVV PYOVO OCLYXPOVN ETTIKOIVGLVIAL.

Mpoxwpwvtag TNV ovAaAuon NG OEIPIOKNC ETIKOIVWVIOG, NApBe n oTiyunl va
TIOPOUCIOCTEL KOl N ATIapaitnTn TEXVNTN 0pOoAOYia, n oTtoia pag gival amapaitntn
ylO TNV PETETIEITO OVAALCN HOG.

2€ MO OEIPIAKN ETTIIKOIVWVIO, TTaipvouv pépog t€ooepa, Baoika, pépn. To DTE, 10
DCE, to RS232, kabwc¢ kal to Baud Rate.

To DTE eival 10 akpovuulo tou Data terminal equipment, 1o ofoio €ival yia
TIOPAdEIYUA, EVOC TIPOCWTIIKOG UTIOAOYIOTHC.

To DCE eivai 1o akpovuuio tov Data communication equipment, To 0Ttoio €ivai n
OTIOUOKPUOUEVN OUOKELN, ME TNV OTIOIa  ETTIIKOIVWVOUUE. ZTNV  TIPOKEIUEVN
TIEPITITWON, N OTIOPOKPULOUEVN cuOKeLN €ival To X-board.

To RS232, eival 10 akpovUuulo tov Recommended Standard number 232, kai gival
€Va TIPOTOKOAAO, TGEIPIOKIC ETIIKOIVWVIOC.

To Baud Rate, ammoteAei Tov apiBPo 1wV QOpwv, PHECO aE Eva OEVUTEPOAETITO, KATA
TNV JIAPKEIA TOU OTIOIOL N ypouun METAdoong, aAAdlel kataotaon. Agicel va
onueIwdei, kal pye Bacon v eme€nynon tou 6pouv Baud Rate, 611 10 Baud Rate, dev
onuaivel Tavio oV aplBud Twv bits 1ou petadidovial KABe oTiyur, ova

OEVTEPOAETTTO.
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Térog, Ba avagpepbovue oto POopa TNG oeIplakng B0pag. To oroio Boopa,
artoteAeital gite amd 9 pins £ite amno 25 pins. 10 X-board, emdvw, n GeIpIoKr BLpa
TIoU PBpioketal, EXEL g pins, ETTOUEVWE Ba avOADGOLUE OPECWC TIAPAKATW aUToU TOU
gidoug 10 Buopa. Méoa e Eva Buopa CEIPIOKNC YE g pins, TO KABE &va armo ta g
pins givai:

Carrier Detect: EAéyxel edv To DCE gival ouvdedeUEVO PE PO €V AEITOLPYIO
TNAEPWVIKT| YPOpHN

Receive Data: O umtoAoyloTAG OEXETAI TO OEDOUEVA TIOU OTEAVOVTOL OTIO TO
DCE

Transmit Data: O UTTOAOYIOTIC OTIOGTEAAEI Ta dedopeva ato DCE

Data Terminal Ready: O vttoAoyiotr¢ ava@épel oto DCE o1 ival €toiyo va
ETIIKOIVWVNOEl padi Tou.

Signal Ground: To Pin autd €ival otnv yeiwon

Data Set Ready: To DCE ava@¢pel 0Tov LTIOAOYIOTH OTI €ival €TOIMO VO
ETIIKOIVWVNOEl padi Tou.

Request To Send: O vmtoAoyloTAG EpwTA T0 DCE €dv prmopei va Tou OTEIAEL
oedopeva

Clear To Send: To DCE epwTtd TOV UTIOAOYIOTH] €0V UTIOPEI VO TOU OTEIAEL
oedopeva

Ring Indicator: MOAIC €Xel Yyivel N KAon, 0 LTIOAOYIOTAC ETIRERAIWVEL TO

YEYOovOo(g OUTO.

‘Eva byte mou petadidetal péow oEIpIaKnG Bupag, armoteAsital ouvrBwe ato Toug
XOPOKTNPEG Kal amo Ta framing bits. O1 xapoaktrpeg Kupaivovtal amno 5-8 bits, evw
Ta framing bits, amoteAovvtal cuvnBwc amo | bit évapéng petadoonc (start bit), 1

parity bit kait i-2 bit Aféng petddoonc (stop bits).
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MSB LSB

Stait.bit Data bits Parity bit  Stop bits

To parity bit amoteAei pia mOAD aTtAOIKY SIAdIKOGCIO EAEYXOU TWV OEAOUEVWV TIOU
petadidovtal. AloKpPivoupe U0 TIEPITITWOEIC EAEYXOUL: TNV TIEPITIN 10O0TNTA (even
parity), Kal v apTia 1ootnta (odd parity). Ztnv TEPITIA 100TNTA, 0 APIOUOG TwV
bit Twv dedopévwy cuv To parity bit, 6a TIpETEl va TTOPAyoLY Evav TIEPITTO APIBUO
amé dooug (1), Evw oTnVv APTIa I0OTNTA TO id10 ABpoIcua Ba TIPETIEI va TTAPAYEL Eva
aptio aplBuo acwv (). Tov TOTIO eAéyxou, €av Ba &val TUTIOL APTIOG i} TIEPITIAG
I00TNTOG, TOV KOBOPIel 0 OTTOGTOAEAC TV OEDOUEVWV, EVW O TIAPOAATITNG EAEYXEL
edv TIpaypatikG Ta dedopéva TIouv EAABE giavi EyKupa Kal Oev TIEPIEXOLV AABN. Ta
MEIOVEKTNUOTA TOU €AEYXOUL pPECW parity bit, €ival 6T pymopolv va evioToTolv
AGON  dpTiov apiBUoL PETOPROAWV OTa OEOOPEVA, EVW TIOAOTIAG AABN, €ival
OLVATOV VO TIAPAYOUV ATIOTEAECUO, TIWE TA OEAOUEVA QUTA €ival EyKUPD, EVW OUTA

Vo unv givai kaboAou.

310 onueio autd Ba avaeepBoLUE OTO TIPOYPAUUN ETIIKOIVWVIAC TOU NAEKTPOVIKOU
uTIoAOYI0TH, T0 hyperterminal, T0 010i0 KOBIOTA €QIKT TNV ETTIIKOIVWVIO PETAED
TWV UTIOAOYIOTWV KAl TNC OTIOMOKPUOHEVNC OUOKELNC, HEOW  OEIPIOKNG
ETUKOIVWVIOG. TO TIPOYPOUMA, HOC ETUTPETIEI VO TIOPAUETPOTIOIGOVUE TNG CEIPIAKNA
ETTIIKOIVWVIa, divovtag pag tnv duvatotntd, va aAAA{ouvue Kal va TPOTIOTIOI00UE
avAAOyO PE TNV CGUCKELN KOl TIC OVAYKEC ETTIKOIVWVIOC HOC TNV CEIPIOKN Bupa,
oTolxeia 0TW¢: T0 Baud Rate, Tov apiBud twv data bits, Tov apiBuo twv parity bits,

TOV 0pIBPO TwV stop bits, kaBw¢ kai to flow control.
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o EpyOAEgio TTOL XPNOIPOTIOINCAUE

H ouyypo@r Kwdika €yive e yAwaoa C, evw XPNOIKMOTIOINONKE Kal TO0 EPYAAEIo
CodeWarrior IDE/ AXD Debugger yia Tnv eKTEAEGN TWV TIPOYPANHATWY oTov ARM
enegepyaoTn.
MapokATw, TIOPABETOVUE KATIOIEC TIANPOPOPIEC YIa TOV TPOTIO XPRONG TOUL
epyaAeiov avtol. Katapxrv, &ekivaue 1o mpoypaupa CodeWarrior IDE (Start
Programs->ARM Developer Suite->CodeWarrior). Ztnv ouVEXEIQ ONUIOUPYOUUE
€Va VED project aKoAoUBWVTAC T TIOPOKATW PrpoTa

> File->New
EmuAé€te 10 Ttedio Project
Location-> ETAé€Te TO location Tou KaivoUpylou project
Ovopua-> EAéETE €va Ovopa yia To project
Add Files to project: ETuAéETe project-> Add Files

vV V V V

> uvexidoupue Pe To va EI0AYOLUE TIC aTTapaitnTeG pubuioel. Emouevwg, £Xoupe OTL
> KataAAnAeg pubpioelg yia v xprion tou Big Endian tpdmou amobrikevong:
EmAé€te Edit-> DebugRel Settings-> Language Settings
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> Ta toug ARM Assembler, C Compiler, C++ Compiler, Thumb C Compiler

Kal Thumb C++ Compiler eTUAEETE:

> Architecture or Processor: ARM7TDMI

> Floating Point: Pure-endian softfp

> Byte Order: Big Endian

Otav €ipooTe €TOIMOI VA TIPOXWPNOOUUE COTNV  PETAYAWTIION TOU  KWAIKA,

ETUAEYOUE:
> Project-> Debug (or press F5)

> Epoavidetal to AXD mapdBupo. EmAéETe Options->Configure Target
> EmAé€te ARMUL Target (ARM emulator)
> Click configure- olyoupeuteite OTI Ta I6X00ULV TO TIOPAKATW(BAETTE

KOl TNV QWToypa@ia):

> Variant: ARM7TDMI
> Clock: Real - Time
> Floating Point Emulation is checked
> Debug Endian is on Big
> Also No Map File
> NO_FPU Floating point Coprocessor
ARMulator Configuration
Piecesia
Xoiiom:
r Clock,
f* trobted opeed
Choose Tdligel Boaflwne
Target Envnormenh Options
> HOI | File “Twvaiiai Aid W FbeAiig Pont Emulation
ADP 1 SI CA VBnifiMrole Adi 1.2.0 805
1S(H>> - - - - - 2711 - IMIPA* e NBTNE«AN--- Berova DefcuQE ndwn
C Lett f® Big
Reaaro
Start laigsl E rdian
' DebugEndian C Haittoaie EntJan
EOH»I&IIG Merow Map Fli
(s No Map Fib
Diethe ARM Debugger wih tie AflMuwWor'lrahucbm Sel Sirulald The slows you to |- M/\Ffe
executeARM progiarm-vithoul ptyvcaJARM hardware, by nrulathg iteARM
miiuciont n icfiwara 50-c |
Fbobng FfortiCcproewcr
Hdp FPU:  INQ_FPU 3
MMUWJ MMMtion
Eaoslab| PE FAULT_PAGETABLES " 3

0K ] Coree iW*

Edv BéAoupe va TIOPAYOUUE €va OPXEIO PE TNV CUPTIEPIPOPA TOL GUOTIUOTOC,

OKOAOLBOUPE TO TIAPAKATW Prjuata:
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> X1ov AXD Debugger, minyaivete oty emidoyn File-> Load Image - otnv
AloTa ou ep@avidetal eTIAEyoupe 1o OIKO pag AXF apxeio, ToOEKAPOLPE TNV
eruAoyn Profile kau eruAéyoupe to Call graph profiling
> EmuAe€te Options-> Profiling-> Toggle Profiling
> [nyaivete otnv emiAoyn Execute-> Run (or F5), 10 eKTEAOVUE OUTO BULO
(POPEC YIO VA TPEEOVLUE TO TIPOYPOAPHA HOC

3TNV OLVEXEID, EXOUUE:

> EmuAegte Options->Profiling->Toggle Profiling

> X10 AXD Debugger mapdbupo, emiAéyouvue Options-> Profiling-> Write to

File

> Aivoupe €va dvopa Kal armobnkevoupe 1o .prfapxeio o pla tomobeaia

> AVOIyOUUE MIO  YPOPMN

<filename.prfxprofilingReport.txt>"

EVTOAWV

Kal

TIANKTPOAOYOUUE

“armprof

To apxeio mou Ba dnuiovpynBel amod TNV EKTEAECN TOU TIPOYPAUMOTOC, HOIALEL

KATIWC £TOL:

cum%
56.4%

Name

main
gsort
__printf
clock
_sprintf
randomise
hell sort
insert_sort

main
insert_sort
strcmp

79.35%

gs string compare
shell _sort
insert sort

strcmp 66.05%

self%
0.16%
0.44%
0.00%
0.00%
0.34%
0.12%
1.59%
19.91%

19.91%
15.91%
59.44%

3.17%
3.43%
59.44%
66.05%

desc%
55.88%
0.75%
0.00%
0.00%
3.56%
0.65%
3.43%
59.44%

59.44%
59.44%
0.00%

0.00%
0.00%
0.00%
0.00%

calls

1
1
243432

13021
14059
243432
270512

TéNog, €Gv BENOLUE va BPOUUE TOV CUVOAIKO XPOVO EKTEAEGNC TOU TIPOYPAUUATOC,

OKOAOLBOUE TA TIOPOKATW PripoTa:

> X710 AXD mapdBupo, eTuAé€te System Views-> Debugger Internals
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> ETmuAé€Te Statistics
> O apiBuog mouv xapokinpiletal w¢ “Total” oe autd 1o Topdbupo, €ival o

GUVOAIKOC XPOVOC EKTEAECNC TOU TIPOYPAUUATOC HAG

|-| apdptnua B

210 TopOvV Ttapdptnua, Ba dolue TIC PBOCIKOTEPEC EVIOAEC 0 assembly, PEPIKEC
atd TIC OTIOIEC XPNOILOTIOINCOUE KAl OTNV TIPWTN €QAPHOYT KWAIKA TIOU YPAWOUE

(BAeTte Mapdptnua IN).

Assembly EVTOAEQ

Mapakdtw TTapaBETOVE TIC EVIOAEC assembly Tou emeéepyaotry XScale Tng Intel.
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LKcal
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U«d MuitMa

laad Daukia
mm

Stan Maiteta
SuUl- DMMI

SMS

CofitmtM

SOffMIt latMIUPI
nipiBs

na lass

Intel® XScale™ Microarchitecture Assembly Language Quick Reference Card
ARM Instruction Set

Move
NOT
$pSr 0 »Sltan
CPS*to Mittw
Mfstw 1o SPSR
1&fZltt to cpsr
ImnadtelatoSPSR
Nnawdteia to cpsr
Add
tsacanv
sataiallnp
oxitta taiwdioi
SuMiad
«Many
nnrsa suMiacl
ravaisa yAfr-Kt *<h any
catwatlmn
doutte satwatati
MNIRR
aCCURNt
iniikAi bin
uastda®) accanatelatom
Npaad tonj
stoaadaxtaiuiafetoati
iKB*11p. 10kit
Stead 32' 1PM
stow) arcanum» tc w
atiMdaccanutelt32 1 W
stpaaiact«nutate Mw 13 - i0
Count Madinf nms

Maapr. 4t Mwml aocamuM-

ArcaiaulaM IMWII

Arcanum* awx Han

tost
Test -Tta..Uan:»
AND

EOR

ORA

nctaa

Oonpan
nepttn

Mat*

wain

aadavttan»

*fh Bn* aad ncMnn ill

w-» M aad axcMnya (2)

Waal
usm matte atmm™*
Mane* ianl arete»».

Mi
Usar and* kMMu
SHAM

stgnM

Pop. a Btect date laad
Mun land eecAaaoa)
aadfaston CPSR

Usar matte fagMNB

WMf
War mad- ptMteqt

Ma
Utar awda kiMtega

Pasn. at BtoditMte Skoda
Usai awda lafksteis

WMS
Ma

MBvato ARM no Iton coproc

Mdvito oopfK tnn ARM na

Lead capnctssai
Slwa oopaocassof

MWicondWwi Rd. <OpnM2> NzC Rd :- CHfKC
NZC
MRSoX»JI Rd. SPSR Rd * SPSR
MR8IOONIIRd.eps* Rd.CPSR
MSRtcood) SPSR_"flaWs>.Rm SPSR :« Raitsataclad Mae oaft)
MBRIOONdI SPS* 4WdS>. SPSR :* kanatLte isatacUJ Mas onte.
MSRKOftil CPSR.dWds*. #<MM4.ar> CPSR :mInn*t_dr isalacfcd tytH Ofilf
ADtucaadi» Rd. tin. <ot*«e> Nzcv Rd «RaaO»nd2
AOCtoondiai Rd. Rn. <0*TN2> Nzev ‘mRa ¢ 0%ind2 ¢+ C*r»
OADCfxndiRd.Rm.Ra Rd :» SATIRn ¢ Ra. Stfckv. No sMRAotela
OMOOKBMB Rd. Rm. Rn Rd i« SATIRN + SATiRa * 2)1 Stt>. Na skftioUa
88C|caad||8] Rd. Rn. «Opnd2> Nzev Rd > Ra - Opnttt - MOT.Carry.
RttoondBBI Rd. Rn. <0*nd2> Nzcv Rd:-Opiate -Ra.
RfCKondasi Rd. Rn. <Opmd2> Nzev Rd :- CftatC 1 Ra - NOTiCanv)
CeOBlcoadi Rd. Rn.Rn Rd » SATIRn - Ria
CiOSURtomdl Rd. Rn. RI Rd m SATIRnN - SATIRN * 2)1 St)». Nastalldala
MUUcoadHSiRd.Rm.Rs NzC Rd:>iRm * Rsi[31:0t
MLAfOONMBIRd, Rn. Rs. Rn NzC Rd miiRai - Rsi a Rail31:0]
iJMULL|coad!!8|R.Xi.RdHt. Rm. Rs. Nzcv RdM.RdLo:- «BttnadiRn * Rsi
UMLAUCondRSI RdLo. RdMI. Rn. Rs NzCcv RdHLRdLo :- anstmadiRdNIMLo * Rn * RS)
SMUUcondRSi RdLo. RdMI, Rn. Rs NZCV RdM.RdLo »$tinad.Rn * Rsi
8MLAL|eoMISt RdLa. RdM.Rm.Rs NzCcv RdM.RdLostjnad. RdHUtdLo a Rn * Rsi
SMUULtvicoadi Rd. Rm. Rs Rd Rm(x1* RtM Mosaaiiotaia.
1t) sMHrdNa
SMLAwtcmdiRd.Ria.Rs.Rn Rd:«RBaRad»r RSMStt*... N) saaid(4Na.
SMUMfytcaaH Rd. na.Rs.Rn Rd :mRa a iRm * Rsf»TiH7:14| St»». NasIM-l«tala.
8MLAL*.M*d| RdLa. RdM. RIX RS RdM.RdLo:» RAHUWLo a RN * Rsf<| N) stm-Kdata.
CLZjcaadl Rd. nn Rd :mnaakar at Matnf zanas la Rm
MMitoonttaoc, Rn. Rs AMO * iRad31:01 * Rst31:C4i0d.C4 a»CCO(Sftdn
MIAPHIcoadiAecO.Rn.Rs
sAm_adaa>1iRad154| * R$|1S«D a aco0[3»:0|
Miv.-Kondiaoo). RatRs 3cc(d3Wi «sua_awtaad>Rai(d| * Rsf.1i a aoxDia»?»
MARKonll atw). Adb). RaHI Aec(i8P:C-12] * RUIH(T:0]
accOfSIO) m PMLo(31:0]
MRAJoond| Rdlo. RAML accO RdH«31«l > MlLa)dafttaccO(3d32]
RAL(BL:CL *»X>fI(31:0]
Tsrtcaad Rn. <.0ffad2> NzC Uldnta CPSR fbas aa Rn AND OftniC
TECKondl Ra. .Opmt2> NzC
ANDicaadtist Rd. Rn. <Dpndt> NZC Rd:» Rn AND Oarad2
EORfcr«JHS| Rd. Ra. <Opmd2> NzC AB:»NIK*OHNi2
OARtoondM Rd, Ra <0amd2> NzC RdaRnOROatadZ
OtCKx>n4l8i Rd. Ra. <Ok«i*{2> NzC Rd :mRn AND NOT 0(4p<12
NOP R>):«RO
taamteOpdiaMZ.
CMPtcoad m <Oprad2» NzCcv Update CPSR flats aa Rn - 0*n«2
CMNtOOnJ)Ra. <O(HnI2> NZCV Update CP8R rtefs aa Rn ¢ OpndZ
«canditM 1BM IADN PtBla a32MI
SUoomiNM R1M. R1t:-NM latH ARIR aoZMt
BXleant Rn Rif :- Rn CtaMato Tfeumt a RadCd is 1
BLX taM RT4:-R« d. R1S :«MNt Cinaod kwcoaditonal
nxtoom RN RM > Rtf- 4 NTS :m AnfSVI|

LDfiteonl Rd. <4jmda2>
LDRtcondiT Rd. «<AJBO*2P>
LDRtoontiRtS. <ajaoda2>

LDfNcoNt: Rd. <AJROtte2>
LDRtconJ*T Rd. <4jaodt2P>
LDRtOoNtS: Rd. <LM(M>
LDRto.mdIM Rd. <*JM>4*3>
LDRtoonRSM Rd. <RJBOda3>

LDM|toadka_BndMI> RdfL <tatBstpo

Rd:- |Addrass)

Rif :-tedditss|S1:11
-"mjaf. ThantataJdiasslOlfel
Rd:. Zam€(tmdltelafrom »ddres|

Rd:« StaaCatemIM- Horn addNssl|

Rd :m Z»NC*tant|Mr«a*it tom aidrass|
Rd :- 8tfaExfcnd|Mr«aid worn aldiass)

Load 1st at fagtstis fnn |Rd|

LDM|HMMt<A aiodadL> RdfL <TMash»po LoAdratfefcts RttlaM /™ @bt
LDM[MdK|<a_BtodkdL> RdfL <fttasl»po’ —_ . : - — — "
LOMteoadM-DudadL» Rd. <ft#s»po* - —— —-— P |
LORD
STRtcaad Rd. <ajnotte2> HMMUteA
STRtMatBT Rd. <A.aoda2P> |Addiassi .Rd
STRmadB Rd. <Jjaoda2> |JAM*SSf7.0|:- RtSTid
STRIcaataBT Ra <A_m*da2P> |Addiass||7:0]:; Rd|7:0
8TR|caaHHRd. <*_awteS> (Adt>ass)[1fCf .' Rd[)STi
8TMK»ndKajaodMS>Rdia <iagast> Moiaklaf mgkstaas to |Rd)|
STMkcondMjantedt> RdfL <nfKb-* Mon ttt te Us« matte fafleletsm pid| - — ! !
stud

— ten* :- |RaL |Ra| . Rm. Rd :- toap

R
IRb]|7:0) :- Rm(70l. Rd :>tamp

MRCtoondi p«cin*t>, <*pi>. Ra CRn. CRn, <ap2>
MRRC tcoati t"cpaum>. <o*t>. <Rd>, <Ra>, <CRa>
UCRttxmdip<cantet>. <opi>. Ra CRn. CRn. <ep2>
MCRRICOAG! P<iMUBt>. <d*K<M>. <RB>. <CR*>

LDCtcaad MSdtan>. CM. <4_mottei>
STCttxxta p.ctnara>. CRd. <ajaodac>

SWiteaad dnawdJA>
BtPT <aanad_tc>

Pit<UBodtt>

CRd m laittassj
|Addiass( :- CM

SafTAtaa aRNrapd paxasaod tacafito-
PrikafcR i Fitor talw tteOtg stela CteMMcoRdBbnaL.

ha-tcot cacTi. teia
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mwiwiiat*
Lot Lo
HMoLl.LotoHI.HIt: HI

Add
Lo.ind Lo
HItOIO. LotoHLHMoHI
Imiiwdlat»
Attn can/
.am*te SP
‘Wm adins: Hom SP
torn addi-;: tomPC
Set*act
NMn«dtat*3

AKK cany
vaftMiromsP

Nagato

MdRftly

Goman
nofftM
mmwdMte

NotfMafton

ANO

EKIUSHItOR

OR

Ncftar

Kktow NOT

tost its

1*001 «MM
LSLRd.Rs

Logical stfttrtgtt
L8R Rd.RS
Arflhawtt: shft rtglfl
ASR Rd. Rs
RoMtligM

Loagtxanct wtflinfc

Bakn wilh ft* and «xcianf-
CtangatoARM

CAanf- to AMI I Rm(0f =0

*flh hiM M- onset, ward
Ei"|
wftingMMofSdt.Mnfd

Iftiftl>
signed Mftwnrd

K-mmm
SP-nftttM
«MMa

wiflh ImwM - onset. ward

wllzregMMdsel.wo\d
Nfiftitwd
lytoi
SP-ntatve, word
Mtfftto

Plist
PASHWTtIftt
w

. —
— = ——n

MO»' Bd. #<Inn«l_«>
MO» Rd. RBI
MW Bd. Bm

ADO Rd. Rn. #»HmnN_S>
ADO Rd. Rn. Fun

ADORd. Rn

ADORA. #<ftnm*d_ft>

ADC Bd. Rn

AOO 8P. »IWH<.7*4>
ADORd. 8P. #<lrard_g*4>
AOO Bd. PC. MM U*4>
SU8Rd. Rn. Rm

sue Rd. Rn. «<<MM4_3>
SUB Rd. MHMftML«>
secRURN

sue SP. #<Imn*L7+*4>
NE6 Rd. Rm

MUL Rd.Rin

CMPRn, Rn

CMN Rn. Rm

CMPRn. #<ftamdJ>

MOP

ANDRURN

EOB Bd. Rm

ORR Rd. Rm

MC Rd. Rm

M7N Bd. Rm

TSTRnRin

L8L Rd. Rm. #<mn*d.5>
M:-Rd«MS

LSR Rd, Rn. #<ftwMd_5>
Rd:*Rd»RS

ASR Bd Bm. feimn«LS>
Rd:*RdA8BRRs

ROR Rd. Rs

Se*0N» Condtt* RM (ARM sift).

Al notMow-*

MM

MMM

MM met to wftfin *4MD cd canard tetucfc*
KXRm

MX MM

QkWmrdtww

MX Rm

LOR Rd. |Rn. #<IMn«L5*d>)
LORH Bd, |Ra #<MmKL5*2>|
LORi Ml |RL*<ftfinMLS>)
LOB Rd. [Bn. BM

LORN Rd. (Rn. Rn|
LORSMR. |Ra Rn|
LOReMd.IRLRm)

IOMte Rd. |RI. Rm)

LOR Rd. [PC, M*p-4_8*4>)
LOR Md. |SP, #<ftnmad_8+*4>)
LOtftA Rot. dMftst>

SIRRd. |Ra Kftnm*.5-4>)
STRH Rd. |Rfl.#<IfinMit_S*2>|
STR- UL |Ra *<immed.5>|
STRRd. |Rn. Rn)
STRHRd.IRL.RmI

SIR: Rd. [Rn Rn|

STRR. )SP. Mmm*d_e*4>|
SIMM Rrt. <tcgfict>
PUBH<f«gftSt>

PUSH <ngfct. Ub
POP<ngM>

POP<ngRst. PC>

POP cHgftsl. PC>

Rd >linnvd.S
Rd :=Rm
Rd *Rm

Rd :=Rn + mtn»d_3

Rd :=Rn +Rm
Rd :=Rd ¢ Rm

Rd :=Rdalmnwd_d
Rd :=Rd ¢ Rfll ¢ C-bfl

SPmSP e Imm*d 7 - 4
Rd =sp ¢ mmMd.8 * 4

Rd :«(PC AND OtfFFFFFRS] # IT

Rd :=Rn - Rin

Rd:>Rn -ftxnMLS

Rd » Rd - Imm*d_8

Rd :=Rd - Fun -NOT C-II

SP % SP - Mnn*<L7 *4

Rd »- Rm

Rd:=Rm * Rd

uk>>- CPSR tap *n Rn - Rm
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Intel® XScale" Microarchitecture Assembly Language Quick Reference Card
Key to Tables

CODES
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«0btnd2>
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<Imme<L8t>
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<a_indes>
“A_m*IML>
<A_ine<to6»
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baawdtele .alee
Logical sum MbnnedMe
LomcaisMNrtahlinnemate
Artnmelic sbM rt|M bamedMe
Rotate rRRt bntaedtete
Register
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Logfcal sSRM M register
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R«Ul lo TabU CondIBua Ftob] MM
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Reieito Tabu AOXossmg Mode z
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Fun. ASR #dmnud_S>

ABewed SUMS 0-31
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RN LSRRs
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ANawtd SUMS 141

PM FELDS (UK AT LEAST ONE SUFFIX)

ARM ADDRESSING MODES

OI'YT DATA TRANSFER
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Skmed less than

Signed greater man

Signed Uss man or equal
Always inormaty onModi



rI apdptnua [

META OTO TIC ETIEENYNMOTIKEG TIEPIYPAPEC TIOU APOPOVCOV TOV TPOTIO AEITOLPYIaC
KOl TIC PBACIKEC apPXEC AEITOLPYIOG TWV EVOWUOTWHEVWY CULOTNUATWY KOl TIIO
OUYKEKPIUEVO TNC TIAaT@Opuag X-board, eipoaote oe 6éon va mapabéooupe 10
KWOIKO Twv 000 EQAPPOYWV TIOU QAVOTITUXONKOV KOl EKTEAECTNKOV OTNV

OUYKEKPIPEVN TIAATPOPUO.

E@apuoyn 1

H mpwtn €@apuoyr a@opouae tnv dnpiovpyia Twv «dIKwv pac» SWIs (Software
Handlers). Mg 1oV 0p0 «dIKWV HOC» QVAQEPOUAOCTE OTO YEYOVO(G, TWC TETOIOL
€idoug OlOXEIPIOTEC OBIAKOTIWY, £XOLV ULAoToINOei amd TNG PIBAIOBNKEC ToU
eneepyaot) ARM, kail omd tnv opdda avamtuéng tng TAat@oppoc X-board.
‘Exovtag MPEAETNOEl KOl KOTAVONGOEL OAA TO TIOPATIAVW TIOL OVO@EPOVTAl GTNV
gpyaacia, BeAfocape va dnNUIOLPYNCOUPE povol pag Tetola SWIs. O KwdIKaG TG
EQAPPOYNC TIOL avaTITUEaPE akOAouBel. Mpiv Ouwg amod avutd, Ba TIPEMEL va
ava@epOEei TO yeyovog TwG N VAOTIOINGN Kal N EKTEAECN TNC EQOPUOYNG Twv SWiIs,
€yive otov ARMulator, Kal 0x1 TTavw otnv TTAAT@Opua avartuéng Tov X-board. H
AEITOLPYIKOTNTO TIOU TIPOCMEPEL N EQAPUOYN €ival n idla, pe v dla@opd OTi
EKTEAeiTal oTOV LTIOAOYIOTH, host computer, Kal OXlI OTov idl0 TOV ETEEEPYNOTN
ARM, aAAG GTO TIPOYPAUUO TIPOCOU0IWANC TNG ASITOLPYIAC TOL. ATIO TNV EQAPMOYN
n omoia ekteAcital o€ user mode, Tapdyovtal SWIs, Ta oTtoia dnuiovpyolv
€€aipean oTNV KAVOVIKI por) EKTEAECTC TOL TIPOYPAPHUATOC OTOV ETIEEEPYATTH), TOTE
avoAaupavel tnv dlaxeipion Tng e€aipeanc o handler, v diaxelpideTal Kal HETA TO
TIEPOC TNG ETUTUXOUC OIOXEIPIONG TNG, ETUCTPEPEL OTNV KAVOVIKN EKTEAEGN TOUL

TIPOYPAUMOTOC KAI OTIC EVTOAEG TIOL ETTOVTAI TNC EVIOANC SWI.
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Kwdikag Epappuoyng imtg (MEPOCG a)
Dispatcher,c

Ainclude <stdlib.h>
Ainclude <stdio.h>
include "userSWis.h"

/[The below correspondence between processor register numbers and simple numbers is from the ATPCS-
/- ARM-THUMB Procedure Call Standard.
//We use those numbers in SW1_Dispatcher in order to show register rO with the pointer ptr[0].

T Processor Register Numbers
{'ro", 0}, {'ri*, 1> {r2"2} {'r3",3},
<'r4", 4}, {'r5",5> {vye".e}, {'r7"7},
{"r8", 8}, {'r9o", 9}, {'r10", 10}, {'r11",11}
{"'rl2", 12}, {"r13", REG_SP}{"r14", REG_LR}{"r15", REG_PC}*/

extern unsigned int Ang_Handler;
extern unsigned int installSWI_Handler(unsigned int);

//IBelow we define the functions that are called by the SWI_Dispatcher to handle each SWI

void Handle_printC(char c) //Handle SWI 0x100 requests
{

}

char Handle_getC(void) //Handle SWI 0x101 requests
{

)

void Handle_printString(char * str) //Handle SWI 0x102 requests

SWI_WhteC(c);

return SWI_ReadC();

SWIIWTiteO(str);

void Handle_restore(void) //Handle SWI 0x103 requests

{
Ang_Handler=installSWI_Handler(Ang_Handler);

}

unsigned int Handle_getClock(void) //Handle SWI 0x104 requests
{

}

return SW!_ClockO;

45



unsigned int SWI_Dispatcher(unsigned int SW1_num, unsigned imt * ptr)

{

46

int status = 0; //Flag in order to know whether the SW1 request was handled by our SW1_Handler
/lor by the Angel_Handler

switch(SWI_num) //The SWI_num shows the code of the SW1Jnstruction

{
case (0x100):

status = 1;
Handle_printC(ptr[0]);
break;

case (0x101):

status = 1;
ptr[0] = Handle_getC();
break;

case (0x102):

status = 1;
Handle_printString((char *)ptr[0]);
break;

case (0x103):

status = 1;
Handle_restore();
break;

case (0x104):

status = 1,

ptr[0] = Handle_getClock();
break;

default:

status = 0;

break;

}

return status;



Installer.c

<einclude <stdio.h>

#include <stdlib.h> //Declares functions for number alterations, memory
dirtibution, etc.

<¢include "usersSWis.h"

unsigned inNnt Ang_Handler; //The declaration of the original(old)
SWI_handler which is the Angel SWI_Handler

extern SWIlhandlerEntry(void); //A reference to the entry routine

unsigned int installISWI_Handler(unsigned int new_handler) //Our installer
which is changing the handleradress which is

//stored at softvec to the
address of our new handler

{

unsigned int offset,oldvec;

unsigned int *SWIlvec; //A pointer to the address 0x08 of the Vector
Table

unsigned inNnt *softvec; //The current handleraddress

SWilvec (unsigned *) 0xO08;
offset = (*SWilvec) & OXxfff; //We find the used offset whisch is
stored in the last 12 bits of the SWilvec

i offset & OxFFFFFOOO ) //We check if the offset can be
represented using 12 bits
{ //else we send a request to print that
the iIinstallation has failed
SWI_WriteO("Installation of handler failed'™);

exit(0) ;
}
softvec = (unsigned *) (offset + 0Ox10); //We are finding the
address of the current SWI handler(Angel) by adding
//the
offset we found,the 0x08 address of the SWI vector and the 8 bits that
//the

pc is ahead due to the pipelining during the execution time
oldvec = *softvec; //IWe are storing the
address of the old SWI handler in order to use it if
//our
SWI handler can't handle the SWI request
*softvec = new_handler; //IWe are setting
the handleraddress to the address of our SWI handler

return(oldvec);
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void

install_user_SW.Is(void){
installISWI_Handler to

install

the handler

//A wrapper function around

ANg__Handler=installSWI_Handler((int)SwWlihandlerEntry);

userSWIS.h

#ifndef

//The following SWI_numbers wvill

void
char
void
void
unsigned
int

void
void
unsigned
void
void

//The
void
void
char
unsigned

void

#endif

48

iNnt

iNnt

install

/* USER SWIS H

swi(0x100)
swi(0x101)
swi(0x102)
swi(0x103)
swi(0x104)
swi(0x105)
swi(0x106)
swi(0x107)
swi(0x108)
swi(0x109)
swi(0x200)

following SWI_numbers wvill

USER_SWIS_H_INCLUDED

#define USER SWIS H INCLUDED

SWI_printC(char);
SWI_getC(void);

SWI_printString(char *);

SWI_restore(void);
SWI_getClock(void);
SWI_findInt(void);
SWI_writelnt(int);
SWI_CopyFile(char*);
SWI_loadAXF(char *);
SWI_run(unsigned
SWI_CopyMem(unsigned

___swi (Ox000) SWI__WriteC (char) ;

___swi(0x002) SWI_WriteO(char *);

__swi(0x004) SWI_ReadC(void);
iNnt _ swi(0x61) SWI_Clock(void);

user SWis(void);

INCLUDED */

iNnt);

int,

unsigned

be handled by Angel.

be handled by our SWI_handler

iNnt);



swi_handler_entry.s

AREA HandlerEntry, CODE, READONLY
EXPORT SWIihandlerEntry ;Make it visible outside of this file
IMPORT SWI_Dispatcher ;Make it visible inside this file
IMPORT Ang_Handler

SWihandlerEntry

SUB sp,sp,.#4 ;We are subtracking 4 from sp in order to leave room

for storing SPSR for supporting nested
:SWI calls

STMFD sp!, {ro-ri2,Ir} ;We are storing gp registers and the link
register Ir in the stack

MRS r2,spsr ;We are moving the SPSR into the gp r2

STR r2, [sp, #14*4] ;We are storing the SPSR above the gp registers
through the r2 register

MOV n,sp ;We are setting a pointer on the
parameters of the stack through register 1t

LDR ro, [Ir, #-4] ;We are extracting the SWI number through the link
register and store it in the register ro

BIC ro,ro,#oxffoooooo;We are getting the code ofthe SWI by bit-
masking

BL SWI_Dispatcher ;We are going to the body of our SWI
handler

CMP ro,#0 ;We are checking whether for the handling of the

SWI request we are using our SWI handler or
;the old SWI handler(Angel)
LDR r2,[sp,#i4*4] ;We are restoring the SPSR from the sp
MSR spsr_cf,r2
;http://www.arm.com/support/faqdev/i332.html
; Strictly speaking, the '_cxsf form
should be instead of'_cf in these cases to ensure
;compatibility with future ARM
cores which may make use of the x and s fields (unused by all current ARM
processors).

MSREQ cpsr_cf,r2 ;Ifthe SWI request is to be handled from
the old SWI handler we are transferring the value of the
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;register r2(SPSR) to the cpsr
LDMFD sp!, {ro-ri2,Ir} ;We are restoring all the gp registers and the Ir
into their original values
ADD sp, sp, #4  ;We are removing the space that was used for
storing SPSR
LDREQ pc,Ang_Handler ;Ifthe SWI requestis to be handled by the
old SWI handler,we are setting the pc to the
;old SWI handler(Angel)
MOVS pc,Ir We are returning from the handler

END
Kdikag Egappoyng tig (Hépog B)

Dispatcher.c

#include <stdlib.h>

tinclude <stdio.h>

tinclude <string.-h>= //Library for the functions memcpy,memset etc
#include <ctype.h>

#include "userSWis.h"

//Below we define the max/min boundaries for an
integer.A signed integer is a 31 bit(l bit for the signing)
#define max 2147483647 //Max integer
tdefine min -2147483647 //Min integer
#define EI_NIDENT 16

//The below correspondence between processor register numbers and simple
numbers is from the ATPCS-

// - ARM-THUMB Procedure Call Standard.

//\We use those numbers in SWI_Dispatcher in order to show register rO
with the pointer ptr[O].

/> Processor Register Numbers

{"rO", O}, {"rl", 1}, {"I’Z". 2}, {"I’3". 3},
{ran, ay £rse, 5y re. e} o 7y

= 8}, {'ro", o}, {'rio”, 10}, e, 11y,
£z, 123, {'rI3",, REG SP}, {"'rl4"\, REG LR}, {"'rI5", REG PC}

typedef struct //Format of the ELF header structure

{
unsigned char e_ident[EI_NIDENT]; //File info(object file or not)

unsigned short e_type; //Type of
file(relocatable,executable,etc)

unsigned short e_machine; //Target processor(intel
x86,ARM,SPARC, etc)

unsigned int e_version; /IVersion # (to allow for future
versions of ELF)

unsigned int e_entry; //Program entry point(0 if no
entry point)

unsigned int e_phoff; //offset of program header(in
bytes)

unsigned int e_shoff; //offset of section header table
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unsigned int e_flags; //Processor-specific flags

unsigned short e_ehsize; //ELF header's size

unsigned short e_phentsize; //Entry size in pgm header tbl
unsigned short e_phnum; //# of entries in pgm header
unsigned short e_shentsize; //Entry size in sec header tbl
unsigned short e_shnum; //H# of entries in sec header tbl
unsigned short e shstrndx; //sec header tbl index of str tbl

} EIf32 Ehdr;

typedef struct //Program header entry for each segment

{

unsigned int p_type; //Type of segment-loadable,
dll, . ..

unsigned int p_offset; //offset in bytes from the start
of file

unsigned int p_vaddr; //NVirtual address in memory of
segment

unsigned int p~jpaddr; //Physical address in memory of
segment

unsigned int p_filesz; //Number of bytes in the file of
the segment

unsigned inNnt p_memsz; //Number of bytes in memory of the
process

unsigned int p_flags; //Indicates whether segment is

executable
unsigned int p align; //Alignment information
} EIf32 Phdr;

extern unsigned int Ang_Handler; //Address of the
Angel handler(old handler)

extern unsigned int installSWI_Handler(unsigned int); //We create a
connection to the installSWI_Handler

extern SWIlhandlerEntry; //Assembly entry
routine

//Below we define the functions that are called by the SWI_Dispatcher to
handle each Swi

void Handle_printC(char c) //Handle SWI 0x100 requests
{

}

char Handle_getC(void) //Handle SWI 0x101 requests
{

SWI_WriteC(c);

return SWI_ReadC();

void Handle_printString(char * str) //Handle SWI 0x102 requests

{

SWI_WriteO(str) ;

void Handle_restore(void) //Handle SWI 0x103 requests
{
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ANng_Handler=installSWI_Handler(Ang_Handler);

unsigned int Handle_ _getClock (void) //Handle SWI 0x104 requests

{
return SWI_Clock();

int Handle_findint(void) //Handle SWI 0x105 requests
{
char tmp[20],ar[20];
iNnt counter=0,ct=0,i = O,result=0;
tmp[counter] = SWI_ReadC();
//Read the first character from the user

while( tmp[counter] != (char) 10) //\MVhile the incoming character
is different from ENTER(the ASCII encoding for it is 10)
counter = counter + 1;
if(isspace(tmp[counter-1])) { //We don't take into account
the spaces(if the user gives any)

tmp[counter-1] = NULL;
counter = counter - 1;
tmp[counter] = SWI_ReadC(Q);

continue;
}
if(counter == 20) { //IWe accept maximum of 20
characters from the user
SWI_printString("You overpassed string boundaries™);

break;
}
tmp[counter] = SWI_ReadC(Q); //We read the next character
from the user
}
if(tmp[counter] == (char) 10) { //1f the incoming counter is ENTER,
stop
tmp[counter] = NULL;
counter = counter - 1;

while(ct<=counter)
{
ifttmpl[ctl]=(char)47 && tmp[ctl]<(char)58) { //We are locating
the first integer(CO' is 48 in ASCIlI encoding and '9' is 57)

if(ct=0 && tmpl[ct-I] == (char) 45) ( //\We are
checking if the previous character is '-'(signed integer)
ct = ct - 1;
for(i=0;i<=(counter - ct);i++) { //\We are copying
the next section(from the integer or the "-") of the input string
arl[i] = tmpli+ct]; //at a table
}
break;
ct = ct + 1;
}
result = atoi(ar); //IWe are passing this

table to atoi
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the

if(result == max || result == (min-1)) { //IWe are checking iFf

integer exceeds the boundaries

SWI_printString(*'You exceeded the max/min int bounds.\n");

return atoi(ar);

void Handle_writelnt(int integl) //handle SWI 0x106 requests

{

iNnt tmp_integ =0,counter=0,i=0,j=0;
iNnt number[10];

for(i=0;i<10;i++) {

number[i]=0;

}

if(abs(integ)!'=integl) { //I\We are checking if the

integer is positive or negative

SWI_WriteC();
integl = abs(integl); //71f it is negative we

are taking the absolute value

}

while(integl!=0) {

tmp_integ=integl2610; //IWe are finding the

least significant digit of our integer

if(ttmp_integ!=0) {
integl=(integl-tmp_integ)/10; //IWe are shifting left

in order to find the next digit

number[counter]=tmp_integ;

else {
integl=(integl)/1.0;
number[counter]=0;

)

counter=counter-+l;

}

if(counter==0) { //1f the user gave the

number 0

SWI_WriteC(OY);

)

for(=counter-I;j==0;j—) { //IWe are printing the number

the user gave(we are adding the 48-ASCIl encoding for "O'-

SWI_WriteC((char)(number[j]+48)); //in order to take the

right character

}
SWI_WriteC('\n*);

void Handle_CopyFile(char * file_name) //Handle SWI 0x107 requests

{

iNnt handler_open;

iNnt handler_close;
int file_length = O;
iNnt bytes_ not _read=0;
char * char buffer;
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i F((handler_open = SWI_Open(file_name, 1)) == 0) //I\We are
openning the reading file(input)
SWI_printsString("Reading-File open, FAILED! \n');
return;

}

else

if( (handler_close = SWI_OpenCout.txt”, 5)) == 0) //I\We are
openning the write file(output)
{
SWI_printsString(""Write-File open, FAILED! \n");
return;

file_length = SWI_Flen(handler_open); //I\We are
finding the length of the input file

i F(file_length == -1)

{

SWI_printString("Reading File-Length, FAILED! \n™);
else

char_buffer = (char *)(malloc ((file_length));
//Allocate temporary memory to copy the contents of the input file

bytes_not_read=SWI_Read(handler_open, char_buffer,
file__length); //The bytes that were not read and copied to the

//memory from the input file
SWI_Write(handler_close, char_buffer, file_length-
bytes_ not_read);//We are wvritting the contents into the output file

}

if(SWI_Close(handler_close) != 0) //I\We are
closing the output file

{
SWI_printString("Closing Write-File, FAILED! \n");

iIf(SWI_Close(handler_open) != 0) //'\We are
closing the input file

{

}

SWI_printsString("Closing Read-File, FAILED! \n");

unsigned int Handle_loadAXF(char * AXF_Name) //Handle 0x108 requests
iNnt AXF_handler;
iNnt AXF_length;
int i = O;
char * AXF buffer;
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char * memory_buffer;
unsigned int entry address;

EIf32_Ehdr ELF___header;
EIf32 Phdr ELF PrHeadTable;

i F((AXF_handler = SWI_Open(AXF_Name, 1)) == 0) //I\We are
openning the AXF file
{
SWI_printsString("AXF File Open, FAILED! \n™);
return O;

else

i F((AXF_length = SWITFlen(AXF_handler)) == -1) /I\We
are finding the length of the AXF file
{
SWI_printsString("AXF File-Length, FAILEDN\N");
return O;

}

AXF_buffer = (char *)malloc(AXF_length);
//Allocate temporary memory for holding the contents of the AXF file
SWI_Read(AXF_handler, AXF_buffer, AXF_length); /I'\We
are loading the contents of the AXF file

memcpy(&ELF_header,AXF_buffer,52); /I'\We
are copying the first 52 bytes(header size) int the
//ELF
header structure
//Below we are checking iFf the file is an ELF object

file
i F((iNt)ELF_header.e_ident[0] '=0x7f ||
ELF_header.e_ident[1l] !'= 'E' || ELF_header.e_ident[2] !'= ~"L' ||
ELF_header.e_ident[3] != "FY)
{
SWI_printString("This is NOT an ELF Object File!
\n") ;
return O;
}
i F((iNt)ELF_header.evident[5] != 2) //Here
we are checking the code encoding of all data(whether it is
{ //Big

Endian or Little Endian)

SWI__ printString ("Wrong Format! (It is NOT a Big
Endian!) \n");

return O;

}

i F((Nt)ELF_header.e_type !'= 2) //'\We are
checking the identification of the object file type

{

//(Relocatable,Executable or Shared object file)
SWI_printString("NOT an executable file! \n");
return O;
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i F((NY)ELF_header.e_machine != 40) //'\We are
checking the used architecture
{
SWI_printString("NOT ARM target processor! \n");
return O;

entry_address = ELF_header.e_entry; //'\We are
storing the virtual address to which the system first transfers control

if(entry_address == 0)

{
SWI_printsString("No Available Entry Point! \n');
return O;

if(entry_address < 0x12000) //I\We are
checking if the loading address is at a safe location
{
SWI_printString("ERROR in Loading Address...!
\n™); //else we are printing an error message

return O;

if(ELF_header.e_phoff == 0) //I\We are
checking the program header table's file offset
{
SWI_printString("No Available Program Header
table! \n");
return O;

AXF_buffer = AXF_buffer + ELF_header.e_phoff; /I'\We
are moving to the program header table

for (i = O; 1 < ELF_header.e_phnum; i++) //\We
may have lot of entries

{
memcpy(&ELF_PrHeadTable, AXF_buffer,

ELF_header.e_phentsize); //IWe are copying the program header table into

//the ELF program header structure
if(ELF_PrHeadTable.p_type != 1)
//IWe are checking the type of the segment(loadable)

{
SWI_printString("NOT Loadable Segments!

\n") ;
return O;

memory_buffer = (char *)ELF_PrHeadTable.p_paddr;
//We are setting a pointer to the physical address of the memory

//where the segment wvill be written
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memset
(memory_buffer,O,ELF_PrHeadTable.p_memsz);//We initialize with zero all
the memory blocks that wvill be used

i F(SWI_Seek(AXF_handler,
ELF_PrHeadTable.p__offset) =0 ) //We are seeking the beginning of the
segment

SWI_printsString("Seeking File, FAILED!
\n™)
return O;

SWI_Read(AXF_handler, memory_buffer,
ELF_PrHeadTable.p_filesz); //We are loading the segment into the memory
//Here while we load the segment into the memory we
see that (p_memsz-p_filesz) bytes are equal with 0
AXF_Jouffer=AXF_buffer+ELF_header.e_phentsize ;
//I\We are moving to the next segment

}

}
if(SWI_Close(AXF_handler) = 0)
//IWe are closing the AXF file

{
SWI_printsString("Closing AXF File, FAILED! \n™);

free(A;(F_buffer);

//We are clearing the temporary memory space used
return (unsigned int) entry_address;

//for the AXF file

}

unsigned inNnt Handle_Run(unsigned inNnt saddress) //Handle O0x109 requests

{

if(saddress == 0) //'\We are
checking whether the file(code) pointed by the saddress
{ //was loaded

or not
SWI_printstring("File didn't RUN! \n"'");
exit(0);

)

return saddress;

void Handle_CopyMem(unsigned int address, unsigned int data) //Handle
O0x200 requests

{

unsigned inNnt * temp_data;

i (address%4) =0 ) //I\We are
checking if the address is word aligned

{

SWI_printString("MISALIGNED! \n');
return;

else
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temp_data = (unsigned int * ) address; //Data
contents of the address
SWI_printString("Data in that memory address:");

SWI_writelnt((int )* temp_data); //I\We are
printing the data contents
*temp_data = data; //\We are

storing the new data contents in the address
SWI_WriteC("\n");

unsigned inNnt SWI_Dispatcher(unsigned int SWI_num, unsigned int * ptr)
{
iNnt status = 0O; //Flag in order to know whether the SWI request was
handled by our SWI_Handler
//or by the Angel_Handler

switch(SWI_num) //The SWI_num shows the code of the SWI_instruction

{
case (0x100):

status = 1;
Handle_printC(ptr [O]);
break;

case (0Ox101):

status = 1;
ptr[O] = Handle_getC(Q);
break;

case (0x102):

status = 1;
Handle_printString((char *)ptr[O]);
break;

case (0Ox103):
status = 1;
Handle_restore() ;
break;

case (0x104) :

status = 1;
ptr[O] = Handle_getClock();
break;

case (0Ox105):

status = 1;
ptr[O] = (unsigned iNnt)Handle_findint();
break;

case (0x106):

status = 1;
Handle__writelInt((int)ptr[0] ) ;
break;
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case (0x107):

status = 1;
Handle__CopyFile((char *)ptr[O]);
break;

case (0x108) :

status = 1;
ptr[O] = Handle_loadAXF((char *)ptr[O]);
break;

case (0x109):
status = 1;
ptr[13] = Handle_Run(ptr[O]);

storing the entry address of the code in the user link register

break;
in the stack

case (0x200):

status = 1;

Handle_CopyMem((unsigned int)ptr[O], (unsigned
break;

default

status = O;

break;

return status;

Egappoyn 2!

Kwdikag E@appuoyng 2rq
BufStatus.c

tinclude "BufStatus.h"
#include "uhal.h"

//Define output and input buffers
BufOutCharacteristics OutputBuffer;
BufinCharacteristics InputBuffer[MaxNumberOfinputBuffers];

//Function for intialization of the output buffer
void InitializingOutputBuffer(void) {
OutputBuffer.head=0;
OutputBuffer.tail=0;

OutputBuffer.FreeSpace=OutputBufferLength-1;
OutputBuffer._UsedSpace=0;

//'\We are

//which is

iNnptri]);

59



//Function for intialization of a specific input buffer

void InitializingInputBuffer(unsigned int InBufNumber) {
InputBuffer[InBufNumber].head=0;
InputBuffer[InBufNumber].tail=0;

InputBuffer[InBufNumber].FreeSpace=InputBufferLength-1;
InputBuffer[InBufNumber].UsedSpace=0;

void InitializationBothBuffers(void) {
unsigned int i;

for(i=0;i<MaxNumberOfinputBuffers; i++){
InitializinglnputBuffer() ;

InitializingOutputBuffer();

unsigned int getOutputBufferFreeSpace(void) {
return(OutputBuffer.FreeSpace);

unsigned int getOutputBufferUsedSpace(void) {
return(OutputBuffer.UsedSpace) ;

unsigned inNnt getinputBufferFreeSpace(unsigned int InBufNumber) {
return(inputBuffer[InBufNumber].FreeSpace);

// Function that returns used space in input buffer
unsigned inNnt getinputBufferUsedSpace(unsigned int InBufNumber) {
return(inputBuffer[InBufNumber].UsedSpace);

// Function that puts a character in output buffer
unsigned int PutCharacteriInOutputBuffer(char Value) {
iNnt BufStatus=0;

//Here first of all we are checking iFf there is free space for
writting a character in the output buffer
if(OutputBuffer.FreeSpace!=0) {
//IWe are putting the character in the head of the buffer

OutputBuffer. Data[OutputBuffer.tail]l=Value;

//IWe are shifting the head pointer 1 place in order to show
to the next empty entry

OutputBuffer.tail=(OutputBuffer.tail+1)%OutputBufferLength;

//IWe are setting the new values for the UsedSpace and
FreeSpace variables

60



OutputBuffer.FreeSpace--;
OutputBuffer.UsedSpace++;

//IWe are returning O(Successful placement)
return(BufStatus);

else{
BufStatus=I;
//IWe are returning l1(Unsuccessful placement)
return(BufStatus);

// Function that gets a character from the output buffer
unsigned int PopCharacterFromOutputBuffer(char *CharValue) {
iNnt BufStatus=0;

//Here first of all we are checking iFf there is a character for
poping from the output buffer
if(OutputBuffer.UsedSpace!=0){
//We are getting the character shown by the tail

*CharValue=OutputBuffer. Data[OutputBuffer_.head] ;

//IWe are shifting the tail pointer 1 place in order to show
to the next character

OutputBuffer.head=(OutputBuffer.head+1)%6cOutputBufferLength;

//IWe are setting the new values for the UsedSpace and
FreeSpace variables

OutputBuffer.FreeSpace++;
OutputBuffer.UsedSpace--;

//IWe are returning O(Successful poping)
return(BufStatus);

else {
BufStatus=lI;
//IWe are returning 1(Unsuccessful poping)
return(BufStatus);

unsigned inNnt PutCharacterininputBuffer(unsigned int InBufNumber,char
Value) {
iNnt BufStatus=0;
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i F(InputBuffer[InBufNumber].FreeSpace!=0){
InputBuffer[InBufNumber] . Data[InputBuffer[InBufNumber] .tail]l=\Value;

InputBuffer[InBufNumber].tail=(InputBuffer[InBufNumber].tail+1)%Inp
utBufferLength;

InputBuffer[InBufNumber].FreeSpace—;
InputBuffer[InBufNumber].UsedSpace++;
return(BufStatus);

else{
BufStatus=lI;
return(BufStatus);

unsigned inNnt PopCharacterFrominputBuffer(unsigned int InBufNumber,char
*CharValue) {
iNnt BufStatus=0;

i F(InputBuffer[InBufNumber].UsedSpace != 0){
*CharValue=
InputBuffer[InBufNumber].Data[lnputBuffer[InBufNumber].head];

InputBuffer[InBufNumber].head=(InputBuffer[InBufNumber].head+1)%lInp
utBufferLength;

InputBuffer[InBufNumber].FreeSpace++;
InputBuffer[InBufNumber].UsedSpace--;
return(BufStatus);

else {
BufStatus=lI;
return(BufStatus);

Userio.c

#include "serial.-h" //We load the libraries of which the
functions we wvill use
#include "uhal.h"
#include "trongame._h"
#include <stdio.h>
#include <=stdlib.h>
#include <string.h>
<include "my_irg.h"
<include ""timer.h"
<¢include "screen.h"
<¢include "BufStatus._h"
<¢include "userio.h"
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#include <ctype.h>
#include "brh.h"

extern int InTimer;

//Global variable declaration

timer_p Timing; //Structure with the tenths, secs and
mins

volatile int TimerTenths=0;

iNnt ticks;

iNnt GlobalTimer;

unsigned int InputMode=0;

extern ST16C550Reg *Seriall;

//

extern void uHAL/r_Initinterrupts(void);

extern void uHALr_InitTimers(void);

extern iNnt uHALr_RequestTimer(PrHandler,const unsigned char *);
extern int uHALr_SetTimerinterval(unsigned int,unsigned int);
extern void uHALr_InstallTimer(unsigned int);

extern int uJUHALr_FreeTimer(unsigned int);

extern void uHAL.Iir_InitSerial(lunsigned int,unsigned int );
extern void uHALr"Disablelnterrupt(unsigned int);

extern void uHALr_Enableinterrupt(unsigned int);

extern iNnt uHALr_Freelnterrupt(unsigned int);

extern int NumPlayers;

extern inNnt NumComputer;
7/

//Function that puts a string in the output buffer(with busy waiting iFf
the buffer is not empty enough)
void PrintStr(char *s) {

int i=0;

unsigned int tmp;

iNnt Length;

BRHDisablelnterrupt(l1); //Disable Timerinterrupts
Length=strlen(s); //IWe are finding the length of the string

//\MWait until the transmitter holding register is empty
while( (Seriall-=ier & BIT1) !'= 0 );

//1F we can not put the string in the buffer...
i Length > getOutputBufferFreeSpace()) {
Seriall-=ier |= BIT1; //Enable the THR interrupt
while( (Seriall-=ier & BIT1) = 0 ); //\MVait until the buffer
is empty

J

//Put the string in the buffer
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while (s [i] '="\0") {
tmp=PutCharacterinOutputBuffer(sl[i]);

i++;
}
BRHENableInterrupt(l1); //Enable Timer Interrupts
Seriall-=ier |= BIT1; //Enable THR interrupts

//Function that puts a string in the output buffer(without busy waiting
ifT the buffer is not empty enough)
void PrintsStr_no_irg(char *s) {

iNnt i=0;

char ch;

iNnt Length=strlen(s);

//71F we can not put the string in the buffer
while( Length >= getOutputBufferFreeSpace() ) {
PopCharacterFromOutputBuffer( &ch ); //Empty the buffer
until we can
Seriall-=rxtx = ch;

//Put the string in the buffer
while(s[i] ! =*\0 *) {
PutCharacterinOutputBuffer(sli]);

i++;

//Function that calculates the number of ticks
/71t is used as the timer interrupt handler
void IncreaseTimer() {

char String[32];

TimerTenths ++;

/MWe are finding the tenths, secs and mins
ticks=TimerTenths;
Timing.tenths=ticks2610;

ticks=ticks/10;
Timing.secs=ticks%660;

Timing.mins=ticks/60;

//\MVe are savinf the cureent condition, going the cursor at
// the desirable position Iin terminal, putting the time in the

proper format,
/7/ and finally restore previous condition

savecursor_no_irqQ;
sprintf(String,""2002d:26002d.26d"”, Timing.mins, Timing.secs
, Timing.tenths);
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PrintStrAtLoc_no_irq( String, 70, 24 );
restorecursor_no irqQ:

// This function returns the char at the head of the input buffer(with
busy waiting)
char GetChar(int id) {

char CharvVvalue;

//71Ff the poping of the character is not successful do busy waiting
while( PopCharacterFrominputBuffer(id,&CharvValue) ) {

}

return CharvValue;

// This function returns the char at the head of the input buffer(without
busy waiting)
char GetCharNB(int id) ({

unsigned inNnt tmp;

char CharvVvalue;

//Getting the character from the buffer
tmp=PopCharacterFromIinputBuffer(id, SCharValue) ;

//ICheck to see iFf there was a character to the buffer
if(tmp==0) {
return CharValue; //71f there is return the character...

else {
return O; //Else return 0

//Function for initializing the timer
void init_timer(void) {

iNnt tmp;

uHALYCr_Initinterrupts () ; //'We initialize the pHAI
internal interrupt structures

uHALYr_InitTimers(Q; //'\We reset all the timers to

a known state

TimerTenths=0;

uHALYr_ printf ("InitTimer!' \n") ;

/'We install the handler for the system timer and stop the timer

GlobalTimer=uHALr_RequestSystemTimer(IncreaseTimer,(const unsigned
char™)"test");

if(GlobalTimer<=0) {

uHALYr_ printf("Timer IRQ is already assigned!\n"™);

//'\We set the timer interval in microseconds
tmp=uHALYr_SetTimerinterval((unsigned int)GlobalTimer,100000);
if(tmp<0) {

uHALYr_printf("Timer not found\n™);
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//\We are starting the timer
UuHALYr_InstallTimer((unsigned int)GlobalTimer);
BRHENableIlnterrupt(PLAT_TIMERAINT);
uHALr_printf("InitTimer out!\n"™);

//Function that
void SerialHandling() {

implements the serial interrupt handler

char CharvVvalue;

unsigned
unsigned

iNnt tmp;
iNnt tmpl;

iIfC Seriall-=Isr & BITO

interrupt

with CAPS
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CharvValue=

1 F(InputMode==0)
PutCharacterininputBuffer(O,Char\Value);

else

{

LOCK

CharValue=tolower(CharValue);

) | //71F we have a receive trasmit

Seriall-=rxtx;

switch (CharValue) {

case

case

case

case

case

case

case

case

case

case

case

case

>

PutCharacterininputBuffer(1, CharValue) ;

break;
40

PutCharacterininputBuffer(d1,CharvValue);

break;
'S

PutCharacterininputBuffer(d1,CharValue);

break;
g

PutCharacterininputBuffer(l1, CharValue) ;

break;

"Xt

PutCharacterininputBuffer(2, '2%) ;
break;

at:
PutCharacterininputBuffer(2,'4");
break;

A

PutCharacterininputBuffer(2, ' 6");
break;

BV, Ve

PutCharacterininputBuffer(2, '8 ' );
break;

m=
PutCharacterininputBuffer(3,'2");
break;

J
PutCharacterininputBuffer(3.,'4 *);
break;
"t
PutCharacterininputBuffer(3,'6%);
break;

//iNn order to play even



PutCharacterininputBuffer(3,'8");
break;

case 'V
PutCharacterininputBuffer(4,'2 ') ;
break;

case "F':
PutCharacterininputBuffer(4,'4");
break;

case "g':
PutCharacterininputBuffer(4,'6%);
break;

case "K':
PutCharacterininputBuffer(4,'8");
break;

return;

/71 Ff we have a trasmitter empty interrupt
if(TX_EMPTY(UART2_BASE)) {
if(getOutputBufferFreeSpace()!=0) { /71 F there are
characters in the buffer...
tmp= PopCharacterFromOutputBuffer(&CharValue); //take
characters from outbuffer
PUT_CHAR(OS_COMPORT,CharValue);
if(getOutputBufferUsedSpace()==0) { //71Ff outpout
buffer empty
Seriall-=ier &= -~ BIT1; //Disable
THR interrupts

//Function that initialize the serial
void init_ser(void) {
unsigned int tmp;

uHALYCr_ InitinterruptsQ;

BRHDisablelnterrupt(PLAT_UARTINT2); //Disable any serial
interrupts

/\We are intializing the interrupts and the serial
tmp=uHALYr__ Requestinterrupt ( (unsigned
INYPLAT_UARTINT2,(PrHandler)SerialHandling,(const unsigned
char*)"SerialHandling” );
iT (tmp==0){
uHALYr_printf("Requestinterrupt!!! \n");

UHALIr_InitSerial(OS_COMPORT, ARM_BAUD_115200 );

BRHEnNablelnterrupt(PLAT_UARTINT?2); //Enable serial interrupts



Seriall-=ier |= 1; //Enable THR interrupts

return;

}

//Function that uniintialize the serial

void uninit_ser(void) {
uHALIr_InitSerial(OS_COMPORT, ARM_BAUD_115200 ); //reset port
uHALYr_Disableinterrupt(PLAT_UARTINT?2);
uHALr_Freelnterrupt(PLAT_UARTINT?2);

//Function which is called at the end of the program for unintializing
the timer
void uninit_timer(void) {

iNnt tmp;

/\We disable the timer,free the interrupt and update the internal
structure
tmp=uHALr_FreeTimer((unsigned int)GlobalTimer);
if(tmp<0) {
uHALYr_printf("The timer is unknown!\n'™);

// Function that sets which buffers received characters are placed
void SetinputMode(int mode) {
InputMode=mode;

return;

// Function that waits for ""ticks" tenth of a second and returns
void Sleep(int ticks) {
iNnt finalTicks;

finalTicks=TimerTenths—+ticks ;

while(TimerTenths!=finalTicks){ // Wait until

ticks time has elapsed
//mothing

}

return;
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